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Getting Started

This section contains the following topics:

® “Product Overview” on page 1-2

e “Prerequisites” on page 1-4

e “Using This Guide” on page 1-5

¢ “Installation” on page 1-6

e “Hardware and Software Requirements” on page 1-7

e “Setting Up and Verifying Your Installation” on page 1-12
e “Setting Up Your Target Hardware” on page 1-17

e “Setting Target Preferences” on page 1-20

¢ “Code Generation Configuration for Nondefault Processors” on page 1-22
® “Supported Blocks and Data Types” on page 1-26

e “Accessing Utilities for Infineon® C166” on page 1-28

® “Overview of C166 Options in the Configuration Parameters Dialog Box”
on page 1-29



1 Getting Started

Product Overview

In this section...

“Introduction” on page 1-2

“Feature Summary” on page 1-2

Introduction

The Target Support Package™ for Infineon® C166® product is an add-on
product for use with the Embedded IDE Link™ for Altium® TASKING® and
Real-Time Workshop® applications. It provides a set of tools for developing
embedded applications for the C166® family of processors from Infineon®
(http://www.infineon.com/). This includes derivatives such as Infineon
C167 and XC16x, and ST Microelectronics ST10 (http://www.us.st.com).

Used in conjunction with the Simulink®, Stateflow®, and the Embedded IDE
Link products, the Target Support Package product lets you

¢ Design and model your system and algorithms.

¢ Compile, download, run and debug generated code on the target hardware,
seamlessly integrating with industry-standard compilers and development
tools for the C166 microcontroller.

¢ Deploy production code on the target hardware.

Feature Summary

The Target Support Package product is integrated with (and dependent on)
the Embedded IDE Link product. This integration provides capabilities to
the Target including:

¢ A flexible build process, which allows you to automatically create and build
projects in the TASKING EDE using code generated by the Real-Time
Workshop® Embedded Coder™ product.

¢ Customizable project templates for targeting embedded hardware or
instruction set simulator.

¢ Processor-in-the-Loop (PIL) cosimulation techniques to verify generated
code running in an instruction set simulator or real embedded hardware


http://www.infineon.com/
http://www.us.st.com

Product Overview

environment. You can set breakpoints, step through the code, and watch
variables during cosimulation.

e MATLAB® commands to rapidly and easily interact with projects in the
TASKING EDE or debug generated code in the CrossView Pro debugger.

¢ Execution profiling and code coverage reports are returned from the
TASKING EDE to MATLAB for your review.

See “Product Overview”.

The Target Support Package product also provides these features:

® Automatic generation of the main program including singletasking or
preemptive multitasking scheduler

e Scheduler is configurable to allow temporary overruns

® Automated build procedure including starting debugger or download utility

® Support for integer, floating-point, or fixed-point code

® Driver blocks for serial transmit and receive

® Driver blocks for CAN message transmit and receive

e Examples to show you how to integrate your own driver code

e Enhanced HTML report generation provides analysis of RAM/ROM usage;
this i1s in addition to the standard HTML report generation that shows
optimization settings and hyperlinks to generated code files

e Support for CAN Calibration Protocol

¢ External mode for parameter tuning and signal logging

1-3



1 Getting Started

Prerequisites

Note You should familiarize yourself with the Embedded IDE Link
documentation, especially “Getting Started”.

This document assumes you are experienced with the MATLAB, Simulink,
Real-Time Workshop, and the Real-Time Workshop Embedded Coder
products.

Minimally, you should read the following from the “Getting Started” section of
the Real-Time Workshop documentation:

* “What You Can Accomplish Using Real-Time Workshop Technology” This
section introduces general concepts and terminology related to Real Time
Workshop software.

e “Working with the Real-Time Workshop Software” This section provides
several hands-on exercises that demonstrate the Real-Time Workshop user
interface, code generation and build process, and other essential features.

In addition, if you want to understand and use the device driver blocks

in the Target Support Package library, you should have at least a basic
understanding of the architecture of the C166. The C166 User’s Manual (or
corresponding document for your C166 derivative processor) is required
reading. The MathWorks recommends that you read the introduction to the
C166 microcontroller. You can find this document by searching the Infineon
Web site for the C166 family of microcontrollers, at the following URL:

http://www.infineon.com/
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Using This Guide

Using This Guide

Follow this path to get acquainted with the Target Support Package product
and gain hands-on experience with the features most relevant to your
interests:

¢ Read in its entirety, paying particular attention to “Setting Up and
Verifying Your Installation” on page 1-12.

e [f you are interested in using the device driver blocks supplied with the
Target Support Package product, and in deploying stand-alone, real-time
applications on the C166 microcontroller, read Chapter 2, “Tutorial:
Simple Example Applications for C166 Microcontrollers” Work through the
“Tutorial: Creating a New Application” on page 2-3.

¢ Then, if you are interested in using the Target Support Package product for
integrating automatically generated code with your own manually written
device driver code, see “Integrating Manually Coded Device Drivers with
a Simulink Model” on page 3-2. Work though the example provided in
“Tutorial: Using the Example Driver Functions” on page 3-11.

¢ See Chapter 4, “Custom Storage Class for C166 Microcontroller
Bit-Addressable Memory” to find out how to use the Target Support
Package product to take advantage of C166 bit-addressable memory. This
can significantly reduce code size and increase execution speed. There are
examples provided in “Using the Bitfield Example Model” on page 4-3.

® For in-depth information about the device drivers and other blocks supplied
with the Target Support Package product, see Chapter 6, “Block Reference”
It is particularly important to read C166 Resource Configuration, as the

C166 Resource Configuration block is required to use the device driver
blocks.

® To browse the demos available, select Start > Links and
Targets > Target Support Package > Demos.

We recommend you work through the tutorials in this User’s Guide with
step-by-step instructions for using and understanding these demos.
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Installation

Your platform-specific MATLAB Installation Guide provides all of the
information you need to install the Target Support Package product.

As the installation process proceeds, it displays a dialog box where you can
select which products to install.



Hardware and Software Requirements

Hardware and Software Requirements

In this section...

“Host Platform” on page 1-7
“Hardware Requirements” on page 1-7

“Software Requirements” on page 1-9

“Switching Between Hardware Variants” on page 1-10

Host Platform

The Target Support Package product supports only the PC platform: Windows
XP only.

You can see the MATLAB system requirements online at

http://www.mathworks.com/products/system.shtml/Windows

Hardware Requirements

The Target Support Package product may be used to generate programs that
can run on any development board or Electronic Control Unit (ECU) that is
based on the C166 microcontroller.

The Target Support Package product is supplied with default configurations
that have been tested on hardware listed in the following table:

Supplier Board Processor Other
Information
Phytec phyCORE®- | SAF-C167CS-LM | Product code
167 Rapid or KPCM-009-C1U:
Development | SAK-C167CS-LM | C167CS. For
Kit other details, see
phyCORE-167
Phytec phyCORE®- | ST10F2697Z2Q3 Supported, but no
ST10 Rapid longer available
Development commercially
Kit

1-7
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Supplier Board Processor Other
Information
Phytec kitCON-167 | SAB-C167CR-LM | A newer board
C167CR kitCON-16x

(product code
KC-167-KSMO04)
is available. See
Phytec products.
Target Support
Package has not
been tested on the
newer board.

Infineon XC167CI SAK-XC167CI Supported, but no
Starter Kit longer available
commercially
Infineon XC164CM U | SAK-XC164 Supported, but no
CAN Start longer available
Kit commercially
STMicroelectronics | MB449 ST10F252-ABG Supported, but no
ST10F25x longer available
EVA Board commercially

You can switch easily between these configurations. For other hardware
variants, you will need to change the default configuration settings. For
details on this and other requirements, see “Switching Between Hardware
Variants” on page 1-10.

This guide assumes that you are working with the Phytec phyCORE-167CS
development board, and documents specific settings and procedures for
use with the Phytec phyCORE-167CS board, in conjunction with specific
cross-development environments.

If you use a different development board, you may need to adapt these
settings and procedures for your development board.

1-8
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CAN Hardware

If you want to use CAN to transmit or receive CAN messages between your
host PC and your target, you require Vector-Informatik CAN hardware
supported by the Vector CAN Driver Library. You must install the correct
driver libraries to support profiling, downloading, and external mode.

Note For CANcaseXL, you must install both the Vector XL-driver library
and Vector CAN Driver Library vcand32.d11.

For older CAN hardware, you must install the Vector CAN Driver Library
vcand32.d11.

Make sure that the library, vcand32.d11, is placed in the Windows® system32
directory.

Software Requirements

Required and Related MathWorks Products
The Target Support Package product requires these products:

MATLAB

Simulink

Real-Time Workshop

Embedded IDE Link for use with Altium TASKING
Optional: Real-Time Workshop Embedded Coder

= Required for bit-addressable memory feature.

= Required for CCP Data Acquisition (DAQ) List mode of operation.

Simulink® Fixed Point™ software is strongly recommended but not essential,
except for one of the demos: ¢c166_fuelsys.

For information about required products, see
http://www.mathworks.com/products/target-package/infineon-adaptor/.


http://www.vector-informatik.com/vi_can_hardware_en,,223.html
http://www.vector-worldwide.com/downloads/drivers/canlib43.zip
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Supported Cross-Development Tools

In addition to the required MathWorks software, a supported
cross-development environment is required.

® See “Supported Altium TASKING Toolsets” in the Embedded IDE Link
documentation for the currently supported cross-development tools for use
with the Target Support Package product.

¢ MiniMon freeware download and monitor utility

Before using the Target Support Package product with the above
cross-development tools, please be sure to read and follow the instructions in
“Setting Up and Verifying Your Installation” on page 1-12.

Switching Between Hardware Variants

There are many different members of the C166 microcontroller family, e.g.,
C167CS, ST10, XC167CI. For each of these processors, it is appropriate to
use different compiler switches and link libraries. Even if you are working
with a single processor variant, you may need to build for different memory
configurations, for example, depending on whether the application will run
from RAM or flash memory. The compilation settings are captured in the
project file.

The Target Support Package product is supplied with preconfigured projects
for targeting the hardware and simulator for a set of processor variants —
see “Hardware Requirements” on page 1-7. If your hardware variant is not
in this set, then you need to create a new Embedded IDE Link template
project (see “Tutorial: Creating New Template Projects”) and set the C166
code generation options (see “Code Generation Configuration for Nondefault
Processors” on page 1-22).

When switching between target configurations, you should review your
Embedded IDE Link option set and ensure that options are set appropriately

for the new configuration.

Additionally, for each model that you build, you must check, and, if necessary,
change the following settings in the C166 Resource Configuration block:

® System_frequency



Hardware and Software Requirements

® External _oscillator_frequency

To determine the correct value of these parameters, consult your hardware
documentation.

It 1s possible to make all the required changes programmatically: a
convenience function c166switchconfig is provided for this purpose. This
function can be run by double-clicking the block Switch Target Processor
Variant inside any of the demo models.
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Setting Up and Verifying Your Installation
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In this section...

“Setting Up Software” on page 1-12

“Verifying MiniMon Settings” on page 1-13

Setting Up Software

Install the Tasking C Cross-Compiler and CrossView Pro Debugger by
following the instructions provided by Altium Limited.

If the CrossView connection to your target hardware requires a serial
connection, install the MiniMon download utility. By using MiniMon instead
of CrossView to launch your application, the serial connection will be available
for other purposes, if required. If your CrossView connection is via a debug
interface (for example, on XC16x hardware) then it is not necessary to install
MiniMon.

You can obtain the MiniMon download utility for monitoring the serial
interface from the Infineon Web site at this URL:

http://www.infineon.com/

To download the MiniMon utility:

1 Go to the Infineon Web site, and click the sitemap.

2 Select Product Categories > Microcontrollers > Development Tools,
Software and Training -> C166/XC166 Development Tools and Software >
Software Downloads.

Find MiniMon in the table, and download and install Minimon. Version
2.2.33 has been verified with this product.

Minimon may need to be configured for your target processor.
After you install, you must specify the location of MiniMon in the

BootstrapLoaderExe target preference, as detailed in “Setting Target
Preferences” on page 1-20. Check that MiniMon is correctly configured for


http://www.infineon.com
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your target, as detailed in the next section, “Verifying MiniMon Settings”
on page 1-13.

The next sections describe how to configure your development environment
(compiler, debugger, etc.) for use with the Target Support Package product,
and how to verify correct operation. The initial configuration steps are
described in the following sections:

e “Setting Up Your Target Hardware” on page 1-17
o “Setting Target Preferences” on page 1-20

Verifying MiniMon Settings

You must check that MiniMon has the correct target settings. This section
describes MiniMon configuration settings that work for the C167CR processor
and for the C167CS processor. Settings for the C167CS board also work
successfully with the ST10F269. You may be able to use MiniMon to download
onto other processors, however, you must establish a corresponding MiniMon
configuration.

To check settings, start MiniMon, then click Configure Hardware ( A ) in
the toolbar (or select Target > Configuration) and make sure the settings
are as in the following illustrations.

In general, you should choose configuration settings that are consistent with
the values specified in the Tasking EDE project.

Select Settings > Interface and ensure that the settings for the serial
interface match those in the Resource Configuration block of your model.

To set up a configuration for a C167CR:

1 Select C167CR from the Controller type drop-down list.

2 Click Yes three times when prompted by the dialog boxes asking the
following questions:

a Do you want to load default memory units for this Type?

b Do you want to activate the default kernel for this Type?

1-13
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¢ Do you want to load default initialization registers of this Type?

3 Perform the following steps on the Initialize register settings:
a Set SYSCON to 0085.
b Set BUSCONI1 to 049F.
¢ Set ADDRSELL1 to 0006.
d Clear all the other check boxes.

The register settings should look as shown.

This configuration has been verified with a Phytec kc167 (C167CR).

x
— Initialize register — Contraller type

W [svscon =] o5 |C167CR | Chkate [20000000 He
r =l h

— Memary
¥ [BUSCONT N A M
ke I’b‘Dl:)HSEL1 ﬂ IDDDB h < [ [zrm :O0FEOO-OO0FFFF Add
Il I j || h X ESFE :O0FO00-00F1FF

X IDAM :O0FE00-00FDFF )
r | =l h KRAN :00EODO-DDE7FF Ef |
I_ I j I h CAN :00EFO0-00EFFF — |
r =l h
T =l h
r =l h
T =l h
r =l h
Addr r— Initial command calls

[~ Generic 1 I h I h I~ EINIT
[~ Generc 2 I h I h

Clear | Cancel | Ok I

To set up a configuration for a C167CS or ST10F269:

1 Select C167CS-4RM from the Controller type drop-down list.
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2 Click Yes three times when prompted by the dialog boxes asking the
following questions:

a Do you want to load default memory units for this Type?
b Do you want to activate the default kernel for this Type?

¢ Do you want to load default initialization registers of this Type?

3 Perform the following steps on the Initialize register settings:
a Change SYSCON to XPERCON, and set the value to 0403.
b Change SYSCON1 to SYSCON, and set the value to 0085.

The order is important: XPERCON must be above SYSCON.
¢ Set BUSCONTI to 049F.
d Set ADDRSEL1 to 0006.
e Clear all the other check boxes.

The register settings should look as shown.

This second configuration has been verified with phyCORE-C167CS and
on phyCORE-ST10F269 hardware.
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x

— Initialize register

=

[HPERCON

|5vSCaN

[BUSCONT

=
-
-
I
¥ |ADDRSELT
-
-
-
-
-
-

Ll Lef L e Lo Lo Lef e Lef L] Led

- - - ¥ T T T T =T = = =

[~ Generic 1 I

[~ Generc 2 I

— Contraller type

INTERNAL LRON

|C167CS-4RM x| Ckrate |20000000 He
r~Memoary

A M

X SFR :00FEO0-00FFFF Add

* ESFR O0FO00-00F1FF

b InaM :O0FZ00-00FLFF 7 |
¥RAaM cOO0EQOOO-0O0E7FF Edll
CAN :O0EFO0-00EFFF
CANZ :O0EEQO-OOEEFF Remove |
HRAMZ s00Co00-0007FF

:000000-007FFF

r— Initial command calls

[~ EINIT

Clear |

Cancel | Ok I
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Setting Up Your Target Hardware

In this section...

“Jumper Settings for the phyCore-167 Development Board” on page 1-17
“Setting Up XC164CM Hardware” on page 1-17

“Jumper Settings for the STMicrolectronics MB449 ST10F25x EVA Board”
on page 1-18

Jumper Settings for the phyCore-167 Development
Board

This section describes the required connections and jumper settings for the
phyCORE-167CS module with HD200 development board.

After setting up your board, you must configure target settings associated
with the Target Support Package product, as described in the next section.

1 Configure jumpers as detailed in the instructions found in the phyCORE
QuickStart documentation. Note that these settings can be markedly
different from the configuration fresh out of the box.

2 If you are running applications from RAM only, it is useful if the board
starts up in bootloader rather than execution mode. There is one jumper
setting that needs to be changed to achieve this: close pins 1 and 2 on JP10.
This is optional; if you do not close this jumper, then when you download
to the target, you need to keep the Boot switch depressed while pressing
the Reset button.

Connect the supplied power cable to the board, and use the serial cable to
connect the serial port P1 on the board to the serial port of your PC.

Setting Up XC164CM Hardware

See the Embedded IDE Link documentation for information on software
installation.

If you need to profile on XC164CM hardware via the serial port, this is
possible when using CrossView. Check which COM port is assigned to USB
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COM Port. To access the Device Manager where you can see this information,
select Windows Start > Settings > Control Panel, double-click System,
select the Hardware tab, and click Device Manager.

This information can be passed to the profile c166 command as follows:

% assuming that it was assigned to COM4
profile_c166('serial', 'SerialPort', 'COM4")

The MiniMon hyperlink may not be provided at the end of builds for hardware
(e.g. XC164CM U CAN and xc167ci_hw_usb) that has a JTAG interface
available. This is because this hardware uses the JTAG debug interface
instead of a serial connection to ASCO. For hardware with a JTAG interface
there is no conflict between using the CrossView debugger simultaneously
with the ASCO serial interface: in these cases it is recommended always to
use CrossView for downloading and running applications.

Jumper Settings for the STMicrolectronics MB449
ST10F25x EVA Board

Settings not listed here should be as default, as specified by the board manual.

Type Jumper Settings
Boot / Configuration Mode > SW4 Switch 4-5-6: CLKCFGSwitch State:
on-on-off.

Note: With fCPU = 5* fXTAL and
oscillator frequency of 8MHz, the
system frequency, fCPU, is 40MHz

Switch 2-3: SALSEL Switch State:
off-off

Switch 1: WRCSwitch State: off

Boot / Configuration Mode > SW3 Switch 7-8: BUSTYPSwitch State:
off-off

Switch 5-6: BSLSwitch State: on-off
Switch 2: ADPSwitch State: off
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Type Jumper Settings

External Memory J1, 1-2: ClosedNote: Enables
external memory

Reset and Vstby EA jumpers J4, 2-3: Closed Note: Forces EA pin
to Vee level

CAN J11, 1-2: ClosedNote: Connects
onboard CAN transceiver
J11, 3-4: Closed Note: Connects
onboard CAN transceiver
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Setting Target Preferences

This section describes configuration settings associated with the Target
Support Package product. These settings, which persist across MATLAB
sessions and different models, are referred to as target preferences. Target
preferences let you specify the location of your cross-compiler and other
parameters affecting the generation, building, and downloading of code.

1 First you must set up your Embedded IDE Link for Altium TASKING
target preferences to specify the location of your cross-compiler and other
settings. See “Setting Target Preferences” in the Embedded IDE Link for
Use with Altium TASKING documentation.

2 Enter c166utils in the Command Window to open the Target Support
Package Utilities for Use with C166 dialog box.

3 Select Target Preferences, and click OK. This opens the Target Support
Package Target Preferences dialog box.
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I Target Support Package Target Preferences

=101%]

BootstrapLoaderExe d:/applications minimaon/minimon.exe @

i Reset ko Default : QK | Cancel | Help |

4 Edit the settings for your cross-development environment:

® BootstrapLoaderExe specifies the path to your download utility
(MiniMon).

You must check this path and also verify that the Embedded IDE Link target
preferences are correct for your machine. You may need to localize these paths
to suit your PC. You can edit a path by clicking on it. The drive designated in
the path must be either an actual hard drive on your PC, or a mapped drive.
Do not use a Universal Naming Convention (UNC).
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Code Generation Configuration for Nondefault Processors

If you wish to target nondefault processor types, then you need to set some
code generation options in the TLC Options of your model’s configuration
parameters.

If you are using a template that specifies a nondefault processor type (see
“Template Projects” in the Embedded IDE Link documentation), when you
try to build the model, you see a build error message similar to the one in
the following figure.

1 c166_serial_transmit - 10O] x|

Wiewe  Font Size

Message Source Reported by Surmmary

[ Wiiodel errar |c166_seria...|Simulink Error building Real-Time YWorkshop target for block diagra...

0 c166_serial_transmit
Error building Real-Time Yworkshop target for block diagram 't166 serial fransmit. MATLAE errar message:
Error using === callMakeHook p=callMakeHook
The callto c166_make_rbw_hook, during the entry hook generated the following errar:

Error using === ¢166_make_rtw_hook=FcnSetTargetCodeGenOptions

Unahle to determine build settings for the cpu type XC164CM as specified in
CAMATLABWR 2006 b rkite mplatesiC1 64 CM_templatelapp_XC164CM_template pjt. The required build
settings are cputype, twinCARN and targetHeaderFile. For certain processor variants these build setttings are
preconfigured. For cpu type XC164CM there are no preconfigured settings so you must specify these values
explicity. To do this select Simulation -= Configuration Parameters then in the Real-Time YWarkshop panel
specifyvalues far each parameter. Maote that parameter must be setto "0x1 662" for XC1 Bxx devices or
"Ox1 67" for C16x% or ST10 devices,

The build process will terminate as a result.

Cpen | Help | Close |

When you open the Configuration Parameters dialog box, the parameters
you need to set now appear in the TLC Options field. You must replace the
string <ENTER VALUE> for each of the parameters cpuType, twinCAN, and
targetHeaderFile. The following example shows these parameters before
the strings <ENTER VALUE> are replaced.
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#%, Configuration Parameters: c166_serial_transmit/Configuration {(Active) 5[
Select: — Target zelection =)
- Solver .
. Data Import/Export Sustem target file: I c1BE. o ﬂl
- [ ptimization Language: I C LI
& Diagnostics Diescription: Target Support Package IC1
-~ Sample Time -
- Data Yalidity r—Build proc:
N E’; iif;;‘i';'s'm TLC options: [e="<ENTER_VALUE>" -stwinCAN="CENTEF_VALUE >" -atargetti=aderFile="<ENTER_VALLE>"
.. Compatibility I akefile configuration
----Moc!el feteiencing I~ | Generate makefile
- S aving
- Hardware Implementation Make command: I
- hiodel Referencing Template makefile: |
- Real-Time Warkshop
-~ Report
- Comments — Custom storage cla
- Symibals ™ lgnore custom storage classes
-+ Cugtom Code
[RC [T Generate code only Bwild |
- Interface
-~ Code Style
- Templates
- D ata Placement
-~ Data Type Replace... o
- Memony Sections

-~ C166 Options (1]
- Embedded IDE Link

=
J- oK I Lancel | Help | Apply |

An example configured for an XC164CM is shown in the following figure.
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#%, Configuration Parameters: c166_serial_transmit/Configuration {(Active) 5[

Select:

- Solver

- [ata lmport/E xport

- [ ptimization

- Diagnostics

-~ Sample Time

- [ ata Y alidity

- Tupe Conversion
- Connectivity

- Compatibility

- Model Referencing
- S aving

ardware Implementation
odel Referencing
eal-Time Workshop
-~ Report

- Comments

- Symbiolz

-+ Cugtom Code

- Diebug

- Interface

-~ Code Style

- Templates

- D ata Placement

- Data Type Replace. ..
- Memony Sections
-~ C166 Options (1]

- Embedded IDE Link

EE

J.

— Target zelection -

Browse... |

System target file: I c16E.te

Language: I C LI
Description: Target Support Fackage IC1

— Build proc

TLC options: I rceSimulatedR TOStep=1 -acpytype="0x1662" -atwinCAN="1" -atargetH eaderFile="reguc1E6dcm. b
I akefile configuration

I~ | Generate makefile

Make command: I

Template makefile: |

— Custom storage cla:

™ Ignare custom storage classes

[T Generate code only

Build |

=

Apply |

oK I Lancel Help |

Summary of Parameters
The TLC Options edit box includes the following parameters:
cpuType

® 0x167, for C16x and ST10 type processors
* 0x1662, for XC16x type processors

twinCAN

¢ 0 — disabled, for use with processors without TwinCAN support

® 1 —enabled, for use with processors with TwinCAN support



Code Generation Configuration for Nondefault Processors

targetHeaderFile — The file name of the header file for your processor type.
These are found in TASKING ROOT\include directory.

Typical Parameter Configuration
The following table shows a configuration matrix for the parameters cpuType,

twinCAN and the typical configurations used for the processor variants
supported by the product.

Processor Type CPU type TwinCAN
16x, ST 0x167 0 - disabled
XC 0x1662 1 — enabled

Note Driver blocks may not work on unsupported processors.
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Supported Blocks and Data Types

1-26

The Target Support Package product supports the same blocks and data types
as the Real-Time Workshop Embedded Coder product.

Note however
¢ You should not use IEEE values Inf or NaN in your model: these are not

supported and result in an error.

¢ Floating point support is implemented in the software; if speed and ROM
usage are of concern, you should select the option for integer code and avoid
the use of floating-point values in your model. This is detailed in step 9 of
“Tutorial: Using the Example Driver Functions” on page 3-11.

The Target Support Package product provides one block library, containing
seven sublibraries that support different functions, as follows:
e (C166 Drivers Library
= Asynchronous/Synchronous Serial Interface Sublibrary
= CAN Interface Sublibrary
= Execution Profiling Sublibrary
= TwinCAN Interface Sublibrary
= Interrupts Sublibrary
= Utilities Sublibrary
= Digital Input/Output Sublibrary
See Chapter 6, “Block Reference” for details of each block. You can click Help

on the Block Parameters dialog box for the block or access the block reference
page through Help.

The top-level C166 Drivers library contains the C166 Resource Configuration
block. This block supports driver configuration for C166 microcontrollers and
is required if there are device driver blocks in the model. See C166 Resource
Configuration.
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The C166 Resource Configuration block provides information required for
generating timer interrupt code. If you do not include a C166 Resource
Configuration block in your model, the code simply executes as fast as
possible. That is, it 1s not synchronized to real time. This behavior may be
desirable if you are running code on the debugger or hardware simulator.

Caution When using device driver blocks from the Target Support Package
libraries with the C166 Resource Configuration block, do not disable or break
library links on the driver blocks. If library links are disabled or broken,

the C166 Resource Configuration block operates incorrectly. See the C166
Resource Configuration reference page for further information.

Model Reference and Driver Blocks

Referenced sub-models that contain driver blocks (including the C166
Resource Configuration block) cause build failures. All driver blocks from the
Target Support Package product must be placed in the top level model. It is
not possible to include driver blocks in any of the referenced sub-models.

Configuration Class Blocks

Each sublibrary of Target Support Package library contains a configuration
class block that has an icon similar to the one shown in this picture.

DOHOT
CORY

C166
Configuration
Class

Caution Configuration class blocks exist only to provide information to
other blocks. Do not copy these objects into a model. If you do you see an error
dialog box to warn you. This causes build failures.
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Accessing Utilities for Infineon C166

You can open the Target Support Package Utilities for Use with C166 dialog
box by entering ¢166utils in the Command Window or double-clicking
Launch C166 Utilities in the Simulink block library.

You will see the following options:

e Target Preferences. Select this to open the Target Support Package
Target Preferences dialog box.

* Download via Minimon. Select this to use the Minimon utility to
download your application to your target hardware.

1-28



Overview of C166 Options in the Configuration Parameters Dialog Box

Overview of C166 Options in the Configuration
Parameters Dialog Box

When you select a C166 system target file in the Real-Time Workshop
configuration parameters dialog box, additional options appear in the tree:
C166 Options, and Embedded IDE Link.

Select C166 Options (under Real-Time Workshop in the Configuration
Parameters dialog box) as shown in the following figure, to see the following
options:

Include input/output driver function hooks
Use this option to integrate your own device driver code. This is
described in “Calling the Device Driver Functions from ¢166_main.c”
on page 3-6.

The following are all execution profiling controls. See “Overview of Execution
Profiling” on page 5-2.

Maximum number of concurrent base-rate overruns
Option for task execution profiling. See “Task Scheduler Overrun
Options” on page 5-7.

Maximum number of concurrent sub-rate overruns
Option for task execution profiling. See “Task Scheduler Overrun
Options” on page 5-7.

Execution profiling
Option for task execution profiling. See “Real-Time Workshop Options
for Execution Profiling” on page 5-6.

Number of data points
Option for task execution profiling. See “Real-Time Workshop Options
for Execution Profiling” on page 5-6.
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#, Configuration Parameters: untitled/Configuration (Active)

D x

Select: |

™ Inchide input/output driver function hooks
- Solver

- D ata Import/Export haximum number of concurent base-rate ovenuns: I 5
- O plirmization
[ Diagnostics
- Sample Time [ Execution profiling
- D ata VY alidige

- Type Corwersion

- Connectivity

-+ Compatibility

- bodel Referencing

- Saving

ardweare |mplementation
odel Referencing

eal- Time " orkzhop

- Report

- Comments

- Symbols

- Custom Code

- Diebug

- Interface

- Code Style

- Templates

- Data Placement

- [Data Type Replace. ..
- bemary Sections

-~ C166 Ophions (1]

- Embedded IDE Link
4 | _’l_l
J, oK | Cancel | Help | Apply |

M aximum number of concurent sub-rate overuns: I a

Mumber of data points: | 500

nz T

When you select a C166 system target file, the Embedded IDE Link
Configuration Parameters component is automatically added to the model, as
shown following.
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#, Configuration Parameters: untitled/Configuration (Active) |
Select: — Build Canfiguration el
goal:aelimportJExport Build action: I Create Application Project ;I
- Optimization Target Preferences Configuration: I C1E6 ;I Edit Configuration |
[ Diagnostics L :
- Sample Time [~ Add build directory suffis
- D ata VY alidige Build directary suffis:
- Type Corwersion
- Connectivity — Export Handles
-+ Compatibility
- Model Referencing ¥ Export EDE handle to MATLAR base workspace
- Saving EDE handle name: |EDE_Okj
- Hardware |mplementation :
- Wodel Fleferencing ¥ Export Crosshiew Pro handle to MATLAR base workspace
[=]- Real-Time warkshop Croggiew Pro handle name: IXUiew_Dbi
- Report
- Camments — Processar-in-the-Loop [PIL] Yerification
- Spmbols ! : ; :
.. Custom Code [~ Configure model to build PIL algorithm ohject code
- Diebug FIL block action: I Hore LI
- Interface
- Code Style
- Templates b
- Data Placement
- [Data Type Replace. ..
- bemary Sections
- C166 Options (1)
ed IDE Link
i | _>l_I
J Ok I Lancel | Help | Apply |

The Target Preferences Configuration description is automatically set
to C166 to use the predefined C166 project templates. The Embedded IDE
Link options contain settings for configuring the Embedded IDE Link build
process. See the Embedded IDE Link documentation for more information
on these options.
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Tutorial: Simple Example
Applications for C166
Microcontrollers

This section includes the following topics:

¢ “Introduction” on page 2-2

e “Tutorial: Creating a New Application” on page 2-3

¢ “Debugging and Using The Code Profile Report” on page 2-11
¢ “Parameter Tuning and Signal Logging” on page 2-17
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Introduction

This section describes how to use two example models to generate, download
and run stand-alone real-time applications for the C166 microcontroller. The
components required to generate stand-alone code are

® The Target Support Package real-time target

® The example models provided: c166_serial transmit and
c166_serial_io

¢ The Tasking C Cross-Compiler and Tasking CrossView Pro Debugger for
compiling and downloading generated code to the target hardware

As an alternative to CrossView, you can use the MiniMon utility for
downloading an application to your target hardware.

Using these, you can build the complete application. You do not need to
manually write any C code to integrate the generated code into a final
application.

The tutorial “Tutorial: Creating a New Application” on page 2-3 uses two
blocks from the Target Support Package library. For complete information on
the Target Support Package library blocks, see Chapter 6, “Block Reference”.
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Tutorial: Creating a New Application

In this section...

“Tutorial Overview” on page 2-3

“Before You Begin” on page 2-3

“Example Model 1: ¢166_serial_transmit” on page 2-4
“Generating and Downloading Code” on page 2-7

“Example 2: ¢166_serial_io” on page 2-9

Tutorial Overview

In this tutorial, you build stand-alone real-time applications from models
incorporating blocks from the Target Support Package library.

In the following sections, you will

e Examine two models
® Generate code from the models
®* Download and run the code automatically as part of the build process

e Use MiniMon to monitor the code executing on the target

Before You Begin

We assume that you are already familiar with Simulink software and with
the Real-Time Workshop code generation and build process. This tutorial
requires the following specific hardware and software in addition to the
Target Support Package product:

¢ Phytec phyCORE-167CS development board, connected via serial port
to your PC

e Tasking C Cross-Compiler and CrossView Pro Debugger

® MiniMon download utility

You must make sure the target preferences have been set correctly. See
“Setting Target Preferences” on page 1-20.
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Note Make sure the default.ini file in the MiniMon directory is not read
only. This can cause errors.

Example Model 1: ¢166_serial_transmit

In this tutorial you start with a simple example
model, c166_serial_transmit, from the directory
matlabroot/toolbox/rtw/targets/c166/c166demos.

This directory is on the default MATLAB path.

1 Open the model by typing c166_serial transmit at the command line.

This example shows the tutorial model c166_serial transmit at the root
level.

Ceoosern tramsme JAT=TEY

File Edit Yiew Simulation Format Tools Help

D|Dﬁn§|%ﬁ|¢-$ﬁ|9Q|) llinf INolmaI 'I

Simple Serial Transmit Demo

| intSTHello Wedd' [13 10]) |—> Data #3500
Transmit

Text

Serial Transmit

Switch Target o
Configuration e @
C166

Fesource
Configuration

Copyright {c) 19842005 The i athWWors, Inc.

Ready 100%: FixedStepDiscrete
A

The model contains a C166 Resource Configuration object. When building
a model with driver blocks from the Target Support Package library, you
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must always place a C166 Resource Configuration object into the model (or
the subsystem from which you want to generate code) first.

The purpose of the C166 Resource Configuration object is to provide
information to other blocks in the model. Unlike conventional blocks,
the C166 Resource Configuration object is not connected to other blocks
via input or output ports. Instead, driver blocks (such as the ASCO
Serial Transmit block in the example model) query the C166 Resource
Configuration object for required information.

For example, a driver block may need to find the system clock speed
that is configured in the C166 Resource Configuration object. The C166
microcontroller has a number of clocked subsystems; to generate correct
code, driver blocks need to know the speeds at which these clock busses
will run.

The C166 Resource Configuration window lets you examine and edit the
C166 Resource Configuration settings.

2 Double click the switch target configuration block, and then select
c167cs_hw. This selection sets the appropriate System_frequency and
External_oscillator_frequency in the Resource Configuration block and
the Embedded IDE Link option set. See “Option Sets” in the Embedded
IDE Link documentation for more information.

3 To open the C166 Resource Configuration window, double-click the C166
Resource Configuration icon. The picture following shows the C166
Resource Configuration window for the c166_serial_transmit model.

-} C166 Resource Configuration - |EI|5|
| Systerm Configuration |
External_oscillatar_frequency A000000.0
o1 BEdriversidsynchronousiSynchronous Sevial Interface Free_tunning_timer j Mone
Systern_frequency 20000000.0
Systermn_timer jTS, reload fram T2
Timer_interrupt_lewvel j 7
Timer_interrupt_level_group ﬂ 1}
2l |
Status |
e : :I
QK | Apaply | Help |

2-5
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In this tutorial, use the default C166 Resource Configuration settings.

Note If hardware is running at a system frequency other than 20 MHz,
you must change this parameter appropriately.

Otherwise, observe, but do not change, the parameters in the C166
Resource Configuration window. By default, the c166drivers
configuration is selected. This shows parameters for the C166
microcontroller CPU in the System Configuration pane on the right.

View the settings for the serial driver block by clicking the
c166drivers/Asynchronous/Synchronous Serial Interface option
in the Active Configurations pane. These settings are shown in the

following illustration.

-inix]

| Active Configurations |‘ Azynchronous/Synchronous Serial Configuration

c166drivers ----- Bit_rate_achieved 9615.385 &

i 166d) chronous Serial Interf ace4 S it_rate_ideal 9600.0 2
----- Loopback_mode_enable Standard transmitfreceive mode =
----- Mode_contral 3-bit data, asynchronous -
----- Parity_selection MfA -
----- Receive_buffer_size 32 &
----- Receive_inkerrupt_level 14 -
----- Receive_inkerrupt_level_group 1 -
----- SOCON 0x8011 &
----- Stop_bits One stop bit -
----- Transmit_buffer_size 34 &
----- Transmit_interrupt_level 14 -
----- Transmit_interrupt_level _group 0 -

e

Skatus

CE

Ok | Apply | Help |

The settings appear in the Asynchronous/Synchronous Serial
Configuration pane on the right. Do not edit any of these parameters for
this tutorial. To learn more about the C166 Resource Configuration object,

see C166 Resource Configuration.
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5 Close the C166 Resource Configuration window before proceeding.

Generating and Downloading Code
To generate code for the model:

1 Select Simulation > Configuration Parameters.
The Configuration Parameters dialog box opens.

2 Select Real-Time Workshop in the tree, as shown below.

#%, Configuration Parameters: c166_serial_transmit/Configuration {(Active) |
e | — Target selsction =
- Solver i
System target file: [ c1E6.1 _ Bowse.|
- Data Impart/E spert ystem target file: |c c TOWEE
- O plimization Lanquane: I L LI
B Diagnostics Description: Target Support Package
— Build process
TLC options: I -aForceSinmulatedR TOneStep=1
M akefile configuration
MDd_e' Reterencing [T Generate makefile
= Saving
- Hardware Implementation M ke command: I
- Model Referencing Template makefile; I
=R cal-Tim
A — Cuztom storage class
- Comments
- Symbols ™ lgnare custom storage classes
- Custom Code
FLEELE [ Generate code only Build |
- |nterface
- Code Styule 1]
- Templates
- [ata Flacement
- [ata Type Replace...
- Mermany Sections
-~ C166 Ophions [1)
- Embedded IDE Link J
-
J oK. I Lancel Help | Apply |

3 Click Build.
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Alternately, you can go straight to building the model by selecting
Tools > Real-Time Workshop > Build Model or using the shortcut
Ctrl+B.

Watch the progress messages in the command window as code is generated.

4 Enter c166utils in the Command Window to open the Target Support

Package Utilities for Use with C166 dialog box. Select Download via
Minimon to download your application via the MiniMon link. If the
Minimon link has not been generated then your C166 Embedded IDE
Link option set is not compatible with MiniMon downloads. This failure
to generate could be because you are targeting one of the simulator
configurations or your board is using OCDS (on-board wiggler) to connect
to the target. The Minimon option should appear when:

¢ The Embedded IDE Link Build Action is set to Create and Build
Application Project, Create, Build and Execute Application
Project, or Create, Build and Debug Application Project.

¢ The option set is for hardware (rather than simulator).
® You are using a serial connection to connect to your target.

¢ [f you have created your own template projects, the option to generate a
hex file must be selected.

Caution You must ensure the option to generate a hex file is turned
on. If you do not you will see the following warning:

It was not possible to generate a minimon script for this
build. This is because your EDE project template is not

configured to generate a .hex file which is required by

Minimon. To generate a .hex file as part of the build

you need to check the box 'Intel HEX records' in your

EDE project template.

You can change this option via Project -> Project Options
-> Linker/Locator -> Output Format.

When MiniMon is started, a dialog box appears asking you to reset your
hardware.
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5 Press the Reset button on your phyCORE-167CS board or cycle the power,

and then click OK.

You can see progress messages in the MiniMon window as it connects and
then downloads to the target. MiniMon then disappears and the code

begins executing on the t

Verifying Code Executi

1 Start MiniMon (navigate to MiniMon.exe and double-click).

arget.

on on the Target

2 Watch the model output in the MiniMon window. When the application
is running, it sends the text "Hello World" plus a carriage return and a
linefeed over the serial interface.

Example 2: ¢166_serial_io

This example model demonstrates how to use both serial transmit and receive

blocks for the C166 microcontroller. You could use these blocks in this way
with your own Simulink models.

1 Open the model by typing c166_serial io at the command line.

E!clﬁﬁ_serial_io
File Edit Yiew Simulation Format Tools Help

=10l x|

DISEE| 2R dlma(r s o | BEHBEy REES

asco Data
Receive

Sumibylesiolisad Sarial Receive

Serial Input/Output

Convert to ASCI

RSN String |—

Data ) Humiber

String Width
I g

Bytes received Restart

Generate
Fibonacci

Sequence

ia E'E Switeh Target
et Contiguration
c1ee 4

Resource
Configuration

Ready

ASCI Text

|

Copyright (¢) 19942006 The i athWorks, Inc

Text Wifidth

Header Text

bata asco
Transmit

Serial Transmit

[100%

|FixedstepDiscrete

2-9



2 Tutorial: Simple Example Applications for C166® Microcontrollers

2-10

2 Double click on the switch target configuration block, then select c167cs_hw.
This will set the System_frequency and External oscillator_frequency
in the Resource Configuration block and the Embedded IDE Link option set.

3 Press Ctrl+B or select Tools > Real-Time Workshop > Build Model.
Watch the progress messages as code is generated from the model.

4 You can download the application by clicking on the link at the end of the
build log. This link launches Minimon.

MiniMon is started to download the code to the target over the serial
connection. The MiniMon dialog box appears asking you to reset your
hardware.

5 Press the Reset button on your phyCORE-167CS board or cycle the power,
and then click OK.

You can see progress messages in the MiniMon window as it connects and
then downloads to the target. MiniMon then disappears and the code
begins executing on the target.

You can restart MiniMon to monitor the serial interface.

Verifying Code Execution on the Target

1 Start MiniMon (select Start > Programs > MiniMon > MiniMon in
Windows, or navigate to MiniMon.exe and double-click).

2 Watch the model output in the MiniMon window. When the application
1s running, it generates a sequence of 16-bit numbers, converts them to
ASCII characters, and transmits them over the serial interface.

3 If you enter the character r in the MiniMon command line field, the
application restarts at the beginning of the sequence. Examine the model
to see how this works: the Serial Receive block passes the restart command
through to the Generate Fibonacci Sequence subsystem. This subsystem
checks for the restart command.
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Debugging and Using The Code Profile Report

In this section...

“Starting the Debugger on Completion of the Build Process” on page 2-11
“RAM / ROM Code Profile Report” on page 2-13

Starting the Debugger on Completion of the Build
Process

As an alternative to downloading with MiniMon at the end of the build
process, you can start your debugger. Depending on the features provided by
your debugger, you can debug the application either on-chip or on a hardware
simulator.

For this example, you use another demo model, c166_user_io. This model
1s designed to show you how to integrate your own manually coded device
drivers with automatically generated code using the Target Support Package
product. This model is covered in detail in Chapter 3, “Integrating Your Own
Device Drivers”. You use it as an example here because you will typically
need to use the debugger in cases where you are integrating your own code.

Also, note that running the debugger on-chip over the serial interface conflicts
with the serial transmit and receive blocks. The c166_user_io model does not
use serial blocks, so this avoids serial conflicts for this example. If you need to
debug an application that includes the serial transmit and receive blocks, you
must run the debugger using a hardware simulator; alternatively, it may be
possible to run your debugger on-chip without using the serial interface, for
example, if debugging over CAN or JTAG is available.

1 Open the model c166_user_io.
2 Select Simulation > Configuration Parameters.

3 Select Embedded IDE Link in the tree.

2-11
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#, Configuration Parameters: c166_user_io/Configuration (Active)

Select:

- Solver

- [ ata |mport/E #port

- [ ptimization

[=- Diagnostics

- Sample Time

- D ata W alidity

- Type Converzion
- Connectivity

- Compatibility

- Model Referencing
- Saving

ardware |mplementation
odel Referencing
eal-Time Workshop
- Report

- Comments

- Symbols

- Cuztom Code

- Debug

- [nterface

- Code Style

- Templates

- [ ata Placement

- Data Type Replace...
- Memory Sections
- C166 Options (1]

- Embedded IDE Link

-

d|

x|

— Build Configuration 1=

Build action: |{&

Target Preferences Configuration: | C166 LI Edit Configuration |

I Add build directory suffix

Build directory suffis:
— Export Handl

¥ Export EDE handle to MATLAE base workspace:

EDE haridle name: | EDE_Obj

¥ Export CrossView Pro handle to MATLAR base workspace

CrozsView Pro handle name: |><View_Dbi
— Proceszar-in-the-Loop [PIL] Yerification

[ Configure model to build PIL algarithm chiect code

FIL block action: I Iane LI

J

LCancel | Help |

4 Select the Build action Create, Build and Debug Application

Project.

5 Before generating code, check that your target preferences related to the
debugger are correctly configured. See “Setting Target Preferences” on

page 1-20.
6 Click OK.

7 Right-click the controller subsystem and select Real-Time
Workshop > Build Subsystem.

8 Click Build in the next dialog box.

Watch the progress messages in the command window as code is generated.
At the end of the build process, your debugger launches automatically with
the application ready to run. You may now debug the application.
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Note If your model contains a serial transmit or receive block, it is not
possible to perform on-chip debugging over the same serial interface. If you
attempt to use the debugger once your application is running, you will no
longer be able to control the application from the debugger, because the
application is using the serial channel.

RAM / ROM Code Profile Report

The c166_fuelsys model is derived from the fuelsys demo model. The
floating point control algorithm from the original model has been converted
to fixed point to allow efficient code generation for the Infineon C166
microcontroller.

Note This demo requires the Simulink Fixed Point product.

The complete model includes a plant simulation as well as a fixed-point
implementation of the control algorithm. When you generate code for this
example, be sure to generate code for the control algorithm subsystem only:

1 Open the model c166_fuelsys.
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E!clﬁﬁ_fuelsys
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¥
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¥
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¥

h 4

[100% [ [ |ode4s A

2 Select Simulation > Configuration Parameters.

3 Select Real Time Workshop in the tree. Note that the Generate code
only option is not selected. The reason for this step is that the code
generation report obtains information from MAP files that are created by
your cross-compiler during the build process. If the Generate code only
option is on, these files are not generated, which prevents the generation of
the code generation report.

4 Select Report in the tree, and then observe the selected check box Create
code generation report.

Select the Launch report automatically check box.

5 Select Embedded IDE Link in the tree, and observe the Build Action is
Create and Build Application Project. You must have one of the Build
options selected to get the code profile report (with RAM/ROM usage):

¢ Create and Build Application Project
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¢ Create, Build and Execute Application Project

* Create, Build and Debug Application Project
6 Close the Configuration Parameters dialog box.
7 Right-click the fuel rate controller block.

8 From the pop-up menu, select Real Time Workshop > Build Subsystem.
9 On the following dialog box, click Build.

When code generation is complete, the Code Generation Report appears in
your Help browser. Here you can review the RAM and ROM requirements

of the model. To do this, left-click the link Code profile report in the left
list. If you compared with the original floating-point version of the fuelsys
control algorithm: you would find that using the fixed-point implementation
results in a considerable reduction in both RAM and ROM. An example report

is shown following.
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E! Real-Time Workshop Report I [ 3
Back Forward H
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Parameter Tuning and Signal Logging

In this section...

“Methods For Parameter Tuning and Signal Logging” on page 2-17
“Using External Mode” on page 2-17

“Using a Third Party Calibration Tool” on page 2-26

Methods For Parameter Tuning and Signal Logging

The Target Support Package product supports parameter tuning and
signal logging either using Simulink external mode or with a third party
calibration tool. In both cases the model must include a special block, the
CAN Calibration Protocol block.

Using External Mode

The Simulink external mode feature enables you to log signals and tune
parameters without requiring a calibration tool. This section describes the
steps for converting a model to use external mode.

External mode is supported using the CAN Calibration Protocol block and
ASAP2 interface. The CAN Calibration Protocol block is used to communicate
with the target, downloading parameter updates and uploading signal
information. The ASAP2 interface is used to get information about where in
the target memory a parameter or signal lives.

Note You must configure the host-side CAN application channel. See
“Configuring the Host Vector CAN Application Channel ” on page 2-19.

To prepare your model for external mode, follow these steps:

1 Add a CCP driver block.

2 Add a Switch External Mode Configuration Block (for ease of use; you can
also make changes manually).
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3 Identify signals you want to tune, and associate them with
Simulink.Parameter objects with ExportedGlobal storage class. It is
important to set the data type and value of the Simulink.Parameter object.
See “Using Supported Objects and Data Types” on page 2-19.

4 Identify signals you want to log, and associate them with canlib.Signal
objects. It is important to set the data type of the canlib.Signal. See
“Using Supported Objects and Data Types” on page 2-19.

For information about visualizing logged signal data, see “Viewing and
Storing Signal Data” on page 2-21.

5 Load the the Simulink.Parameter and canlib.Signal data objects into
the base workspace.

6 Configure the model for building by double-clicking the Switch External
Mode Configuration block. In the dialog box, select Building an
executable, and click OK.

7 Build the model, and download the executable to the target

8 After downloading the executable to the target, you can switch the model to
external mode by double-clicking the Switch External Mode Configuration
Block. In the dialog box that appears, select External Mode, and click OK.

9 You can now connect to the target using external mode by clicking the
Connect button.

10 If you have set up tunable parameters, you can now tune them. See
“Tuning Parameters” on page 2-20.

If you do not want to use the Switch External Mode Configuration block, you
can configure for building and then external mode manually. For instructions,
see “Manual Configuration For External Mode” on page 2-24.

See the following topics for more information:

¢ “Configuring the Host Vector CAN Application Channel ” on page 2-19
¢ “Using Supported Objects and Data Types” on page 2-19

® “Tuning Parameters” on page 2-20
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* “Viewing and Storing Signal Data” on page 2-21
e “Manual Configuration For External Mode” on page 2-24

¢ “Limitations” on page 2-25

Configuring the Host Vector CAN Application Channel

External mode expects that the host-side CAN connection is using the
'"MATLAB 1' application channel. To configure the application channel used
by the Vector CAN drivers, enter the following at the MATLAB command line:

TargetsComms_VectorApplicationChannel.configureApplicationChannels

The Vector CAN Configuration tool appears. Use this tool to configure your
host-side CAN channel settings.

If you try to connect using an application channel other than 'MATLAB 1',
then you see the following warning in the command window:

Warning:
It was not possible to connect to the target using CCP.
An error occurred when issuing the CONNECT command.

Using Supported Objects and Data Types
Supported objects:

e Simulink.Parameter for parameter tuning

® canlib.Signal for signal logging
Supported data types:

* uint8, int8
®* uintl6, intl6
* uint32, int32

® single

2-19



2 Tutorial: Simple Example Applications for C166® Microcontrollers

2-20

You need to define data objects for the signals and parameters of interest for
ASAP 2 file generation. For ease of use, create an MATLAB file to define the
data objects, so that you only have to set up the objects once.

To set up tuneable parameters and signal logging:

1 Associate the parameters to be tuned with Simulink.Parameter objects
with ExportedGlobal storage class. It is important to set the data type
and value of the Simulink.Parameter object. See the following code for an
example of how to create such a Simulink.Parameter object for tuning:

stepSize = Simulink.Parameter;

stepSize.DataType = 'uint8';
stepSize.RTWInfo.StorageClass = 'ExportedGlobal';
stepSize.Value = 1;

2 Associate the signals to be logged with canlib.Signal objects. It is important
to set the data type of the canlib.Signal. The following code example shows
how to declare such a canlib.Signal object for logging:

counter = canlib.Signal;
counter.DataType = 'uint8';

3 Associate the data objects you have defined in the file with parameters or
signals in the model. For the previous code examples, you could set the
Constant value in a Source block to stepSize, and set a Signal name
to counter in the Signal Properties dialog box. Remember that stepSize
and counter are data objects defined in the code.

Tuning Parameters
To tune a parameter, follow these steps:

1 Set dataobject.value in the workspace while the model is running in
external mode. For example, to tune the parameter stepSize (that is, to
change its value) from 1 to 2, enter the following at the command line:

stepSize.value = 2
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You see output similar to the following:
stepSize =

Simulink.Parameter (handle)
RTWInfo: [1x1 Simulink.ParamRTWInfo]

Description: ''
DataType: 'uint8'
Min: -Inf
Max: Inf
DocUnits: ''
Value: 2

Complexity: 'real’
Dimensions: [1 1]

2 Return to your model, and update the model (press Ctrl+D) to apply the
changed parameter.

Viewing and Storing Signal Data

To view the logged signals attach a supported scope type to the signal (see
“Limitations” on page 2-25 for supported scope types).

Select which signals you want to log by using the External Signal &
Triggering dialog box. Access the External Mode Control Panel from the Tools
menu, and click the Signal & Triggering button. By default, all displays
appear as selected to be logged, as shown in the following example. Edit
these settings if you do not want to log all displays. Individual displays can
be selected manually.
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2 ExternalModeExample: External Signal & Triggering - |EI|5|
Signal zelection
Block Path
X Display ExternallodeExanple /Display ;l [V Select all
W Scopel ExternalModeExanple/3copel Clear A1
X Scopez ExternalModeExanple/Scopesd —I
X Scopeld ExternalModeExanple/3copel  on
X Scoped ExternalModeExanple/Scoped
= off
Trger Signal |
j o To Blash |
Trigoer
Source manusl v | Mode [normal - | TPEEEC SO0EE Part: i ElEmment: fany
foo T =l
Duration: {000 Delary:
I]
[ &rm when connecting to target [itection Irising d LLevel: p e[ s h
Rewvert | Help I Apply I Cloze I

Storing signal data for further analysis. It is possible to store the logged
data for further analysis in MATLAB.

1 To use the Data Archiving feature of external mode, click Data Archiving

in the External Mode Control Panel. The External Data Archiving dialog
box appears.
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) ExternalModeExample: External Data Archiving - |EI|£|

Drata archiving
[+ Enakle archiving

Directary: ICZ WTEMPExternaltode [ Incremert directary swhen trigger armed

File: 'Ex‘ternalMDdeData [~ Inerement file after one-shat

D Bleeaiy (oo I I_ Append file suffix to variable names

[ 'wirite intermediste results to workspace
Edlt File Mote... |

Rever‘tl Helg | Cloze |

a Select the check box Enable archiving
b Edit the Directory and Filename and any other desired settings.

¢ Close the dialog box.

2 Open the Scope parameters, and select the check box Save data to
workspace.

) "Scoped’ parameters =1E) x|

General | Diata history Tig: try right clicking on axes

[ Limit data poirts to last: IS':":":'

v Save datsto workspace

Watiakle name: ISu:u:upeDataS

Format: IStruu:ture with time j

Ok | Cann::ell Helg | Apply
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3 You may want to edit the Variable name in the edit box. The data that is
displayed on the scope at the end of the external mode session is available
in the workspace with this variable name.

The data that was previously displayed in the scope is stored in .mat files
as previously setup using Data Archiving.

For example, at the end of an external mode session, the following variable
and files could be available in the workspace and current folder:

® A variable ScopeData5 with the data currently displayed on the scope:

ScopeData5
ScopeData5 =

time: [56x1 double]
signals: [1x1 struct]
blockName: 'mpc555rt_ccp/Scopel’

¢ In the current folder, .mat files for the three previous Durations of
scope data:

ExternalMode 0.mat
ExternalMode 2.mat
ExternalMode_ 1.mat

Manual Configuration For External Mode

As an alternative to using the Switch External Mode Configuration block, you
can configure models manually for build and execution with external mode.

To configure a model to be built for external mode:
1 Select Inline parameters (under Optimization in the Configuration
Parameters dialog box). The Inline parameters option is required for

ASAP2 generation.

2 Select Normal simulation mode (in either the Simulation menu, or the
drop-down list in the toolbar).
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3 Select ASAP2 as the Interface (under Real-Time Workshop, Interface,
in the Data Exchange pane, in the Configuration Parameters dialog box).

After you build the model, you can configure it for external mode execution:

1 Make sure Inline parameters are selected (under Optimization in the
Configuration Parameters dialog box). The Inline parameters option is
required for external mode.

2 Select External simulation mode (in either the Simulation menu, or
the drop-down list in the toolbar).

3 Select External mode as the Interface (under Real-Time Workshop,
Interface, in the Data Exchange pane, in the Configuration Parameters
dialog box).

Limitations

Logging of multiple signals feeding the same scope block is not supported.
Instead, log each signal with its own scope block. These multiple signals can
be on the same Simulink line, or can be multiple lines feeding the same scope
(i.e. the scope can have multiple axes).

Only the following kinds of scopes are supported with External Mode Logging:

® Simulink Scope block
¢ Simulink Display block

® Viewer type: scope — To use this option, right-click a signal in the model,
and select Create & Connect Viewer > Simulink > Scope. The other
scope types listed there are not supported (e.g., floating scope).

Before connecting to external mode, you also need to right-click the signal,
and select Signal Properties. In the dialog box, select the Test point
check box, and click OK.

GRT is supported but only for parameter tuning.

If a signal comes directly from a Rate Transition block, external mode may fail
to detect the correct sample time. To work around this, place a non-virtual
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block (e.g., Contiguous Copy) in between the Rate Transition block and the
signal to log.

It is not possible to log signals with very fast sample times (e.g., 0.0001)
without losing data.

Subsystem builds are not supported for external mode, only top-level builds
are supported.

Logging and tuning of nonscalars is not supported. It is possible to log
nonscalar signals by breaking the signal down into its scalar components. For
an example of how to do this signal deconstruction, see the CCP demo models,
which use a Demux and Signal Conversion block with contiguous copy.

Logging and tuning of complex numbers is not supported. It is possible to
work with complex numbers by breaking the complex number down into its
real and imaginary components. This breakdown can be performed using
the following blocks in the Simulink Math Operations library: Complex to
Real-Imag, Real-Imag to Complex, Magnitude-Angle to Complex, Complex
to Magnitude-Angle.

Using a Third Party Calibration Tool

The Target Support Package product allows an ASAP2 data definition file
to be generated during the code generation process. This file can be used

by a third party tool to access data from the real-time application while it
1s executing.

ASAP2 is a data definition standard by the Association for Standardization
of Automation and Measuring Systems (ASAM). ASAP2 is a standard
description for data measurement, calibration, and diagnostic systems. The
Target Support Package product lets you export an ASAP2 file containing
information about your model during the code generation process. See also
“Compatibility with Calibration Packages” on page 7-31.

Before you begin generating ASAP2 files with the Target Support Package
product, you should read the “Generating an ASAP2 File” section of the
Real-Time Workshop documentation. That section describes how to define
the signal and parameter information required by the ASAP2 file generation
process.
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Select the ASAP2 option before the build process as follows:

1 Select Simulation > Configuration Parameters.

The Configuration Parameters dialog box appears.

2 Select Interface (under Real-Time Workshop) in the tree.

3 Select the ASAP2 option from the Interface drop-down menu, in the Data

exchange frame, as shown following.

#4, Configuration Parameters: c166_serial_transmit,/Configuration {Active)
Select: — Software envirohment
-~ Solver il
- Data Import/Export T arget function librany: ICSS.-"EISD [&MSI) LI
- O ptimizatian Lltility function generation: | Shared location j
EI--Dlaggostlcl:s T Support: [~ floating-point numbers I~ | nonfirite numbers I™ complex numbers
- Sample Time I | : i :
- Data Walidity [T abszolute time [T contiruous time [T mordirlined 5-functions
- Type Cofﬂ\."ersmn — Code interfac
- Connectivity
- Compatibility I~ GRT compatible call interface ¥ Single output/update function [ Teminate function required
----Moc!el Referencing [T Generate reusable code
- Saving

- Hardware Implementation [T Suppress emar status in realtime model data stucture

- Model Referencing

-~ Data Placement

[=-Real-Time Workshop et
- Report Support software-in-the-loop [SIL] testing
- Comments
- Symbols ’7|_ Create Simulink [S-Function] block [™ Enable partable word sizes
- Cuztom Code 5 7
- Debug [ MAT-file logging
- Interface — Drata exchang
- Code Style
- Templates Interface:

- Data Type Replace. ..
- bemory Sections

- C166 Optionz (1]

- Embedded IDE Link TS

" | )

Lancel Help | Apply

4 Click Apply.

The build process creates an ASAM-compliant ASAP2 data definition file for

the generated C code.

¢ The standard Real-Time Workshop ASAP2 file generation does not
include the memory address attributes in the generated file. Instead,
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it leaves a placeholder that must be replaced with the actual address by
postprocessing the generated file.

® The map file options in the template project need to be set up a certain way
for this procedure to work. If you have created your own template projects,
and you do not have the correct settings, you see the following instructions:

Warning: It was not possible to do ASAP2 processing on your
.map file.This is because your EDE project template is not

configured to generate a .map file in the correct format.

To generate a .map file in the correct format you need to

setup the following options in your EDE project template:

Generate section map should be checked on

Generate register map should be checked off

Generate symbol table should be checked on

Format list file into pages should be checked off

Generate summary should be checked off

Page width should be equal to 132 characters

Symbol colums should be 1

You can change these options via Project -> Project Options
-> Linker/Locator -> Map File -> Map File Format.

The Target Support Package product performs this postprocessing for you. To
do this, it first extracts the memory address information from the map file
generated during the link process. Secondly, it replaces the placeholders in
the ASAP2 file with the actual memory addresses. This postprocessing is
performed automatically and requires no additional input from you.

For an example of a model that is configured to generate an ASAP2 file, see
c166_ccp.



Integrating Your Own
Device Drivers

This section includes the following topics:
® “Integrating Manually Coded Device Drivers with a Simulink Model” on
page 3-2

e “Preparing Input and Output Signals to the Device Driver Functions ”
on page 3-3

e “Calling the Device Driver Functions from ¢166_main.c” on page 3-6
¢ “Adding the I/O Driver Source to the List of Files to Build” on page 3-9

e “Tutorial: Using the Example Driver Functions” on page 3-11
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Integrating Manually Coded Device Drivers with a
Simulink Model

The Target Support Package product has a limited set of I/O device driver
blocks. This means that, for most applications, it is necessary to manually
write some device driver code.

This approach requires the following steps:

1 Identify the model inputs/outputs that must be read from/written to device
driver functions.

2 Set the data type and storage class for each input or output signal so that it
is compatible with your device driver code.

3 Use the hooks provided in the automatically generated c166_main.c to call
your device driver initialization, input, and output functions.

4 Add your device driver source code to the list of files that must be included
in the build process.

Each of these steps is described in the following sections. An example model
is provided: c166_user_io.

An alternative approach is to create Simulink I/0O blocks that automatically
generate the device driver code. This approach may be worth considering if
you need to reconfigure the I/O behavior frequently. If you want to take this
alternative approach, you should consult the documentation on S-functions

and TLC. See the section Developing Device Drivers for Embedded Targets

in the document Developing Embedded Targets in the Real-Time Workshop
Embedded Coder documentation.

A useful tool for creating C166 device drivers is the freeware Digital
Application Engineer DAVE from Infineon. You can find this at the following
URL:

http://www.infineon.com/dave

Using this package along with the hardware User’s Manual greatly eases the
task of developing your own device driver code.


http://www.infineon.com/dave

Preparing Input and Output Signals to the Device Driver Functions

Preparing Input and Output Signals to the Device Driver

Functions

Structure your model similarly to c166_user_io. Place the control algorithm
that will be targeted onto the C166 microcontroller hardware in a separate
subsystem. Before generating code, you can run this model in closed-loop
simulation; this allows you to validate the correct behavior of your control
algorithm before running it in real time.

When structuring your model in this way, you should make sure that all the
input and output signals to the control algorithm are channeled through
top-level input or output ports in the control algorithm subsystem.

By default, when you generate code for the control algorithm subsystem,

the Real-Time Workshop build process chooses variable names and data
structures for each of the top-level input and output signals. However, in this
case, you must ensure that the variables are global, and that their names
and data structures match those that are required by the manually written
device driver functions.

The example model c166_user_io illustrates some alternative ways to
achieve this. The simplest method is to

1 Select one of the signals in your model connected to a top-level output
port in the control algorithm subsystem. As an example, open the demo
c166_user_io.

2 Open the controller subsystem.

3 Click the output_PWMO signal.

4 Select the menu item Edit > Signal Properties.

The Signal Properties dialog box appears, as in the example following.
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E Signal Properties: output_PWMO ﬂ

Signal name: |output_Pw/t0

[ Signal name must resolve ta 5i

Logging and accessibility | i
RT' starage class: I ExportedGlabal ﬂ
RT storage tppe qualifier; I

Ok LCancel | Help | Apply |

5 Enter the required variable name for your signal in the Signal name
edit box. This must match the variable name required by your manually
written device driver functions.

6 Click the Real-Time Workshop tab and select ExportedGlobal from the
RTW storage class drop-down menu.

When you generate code for this model, the Real-Time Workshop build
process uses the variable name that you have specified and creates an extern
declaration in the model header file. By using a #include directive to include
this model header file in your device driver source code, it is possible for the
device driver functions to read or write this variable that is defined in the
Real-Time Workshop generated code.

A more sophisticated approach is to use custom storage classes. By using
custom storage classes, you can collect a number of input or output variables
together into a C struct, resulting in more readable code. The LED output
signal in the c166_user_io uses a custom storage class, which uses a single
bit in a bitfield variable. See “Tutorial: Using the Example Driver Functions’
on page 3-11 for details about the different ways the model variables are
defined and referenced to interface the manually coded driver functions and
the automatically generated code.

4
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By defining your own custom storage classes, you have complete control over
the data structures that are used for any signal in the model. See the custom
storage class documentation in the Real-Time Workshop Embedded Coder
documentation for more details.
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Calling the Device Driver Functions from ¢166_main.c

You should check the option to include I/O driver function hooks. When you
use Real-Time Workshop code generation for this model, it includes some
extra calls to user-supplied I/O device driver functions:

1 Select Simulation > Configuration Parameters.

The Configuration Parameters dialog box appears.

2 Select C166 Options (1), under Real-Time Workshop in the tree, as
shown in the example below.



Calling the Device Driver Functions from c166_main.c

#%, Configuration Parameters: c166_user_io/Configuration (Ac ) x|
Select: | =

v Include inputoutput driver function hooks
- Solver

- Data lmpart/Export b amimunn number of concurent baze-rate ovenung I ]
- O ptimization ’
F' . b amimunn number of concurent sub-rate ovenung I'I
[=- Diagnostics

[ Execution prafiling

MHumber of data points; | 500

- Hardware Implementation
- bl ndel Referencing
F-Real-Time Waorkshop
- R eport

- Comments
- Symbols
- Custom Code
- Diebug
- |nterface
- Code Styule
- Templates
- [ata Flacement
- [ata Type Replace...
- b emony Sections

& 166 Options (1]
- Embedded IDE Link

‘ | u
\} Ok I LCancel | Help | Apply |

3 Select the check box option for including I/O driver function hooks.
These functions are

user_io_initialize — called following model initialization

base _rate model inputs — read model inputs, called at the base
sample rate

base_rate model outputs — write model outputs, called at the base
sample rate
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sub_rate i model inputs — read model inputs, called at the start of
sub-rate 1, where 1=1, 2, ...

sub_rate i model outputs — write model outputs, called at the start
of sub-rate 1, where 1=1, 2, ...

If you are using the automatically generated c166_main.c, then these
function names are fixed.

For an example implementation of these functions, open the model
c¢166_user_io and follow the link to open the I/O driver source files. These
are described in “Tutorial: Using the Example Driver Functions” on page 3-11.
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Adding the 1/O Driver Source to the List of Files to Build

You must tell the Real-Time Workshop build process to compile and link the
I/0 driver source files that you have written. You do so by adding the files to
the custom code dialog box. Access the Configuration Parameters dialog box,
look under Real-Time Workshop > Custom Code, and add the necessary
Include Directories and Source Files, as shown in the following figure.

#4, Configuration Parameters: c166_user_jo/Configuration {Active) ﬂ
Select: | — Include custom c-code in generated: 1=
RIS Sourze file Source file;
- D ata Import/E xport Header file
D!:tlmlzat.lon Initialize function
& D!agnastlcs ) Terminate function
i~ Sample Time
i Diaka Validity
Type Conversion
Caonnechivity
i~ Cornpatibility
todel Referencing
L S aving

- Hardware [mplementation
- hModel Beferencing
=~ RealTime Warkshop
-~ Report
- Comments
- Spmbols

Include lizt of additional:

- Diebug

Include directanies  Include directaries:
~ Interface Source files oy "
- Code Style Librari CAMATLABM oolboxrtwitargets\c1Bb\e 166 demasiuser_src
\orarnes
- Templates b

- [ata Placement

- Data Type Replace...

- Memary Sections
166 Options [1)

-~ Embedded IDE Link

- | s
»,_) 0K I LCancel | Help | Apply |

You are now ready to build your model and run it in real time.
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You can examine an example of this in the example model ¢c166_user_io. See
the instructions in “Tutorial: Using the Example Driver Functions” on page

3-11. Step 8 shows you how to specify the location of your own manually
coded drivers.
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Tutorial: Using the Example Driver Functions

The example model c166_user_io demonstrates how to integrate user-defined
device driver code. In this tutorial, you generate code from the controller
subsystem, which automatically downloads and runs on the target.

The model c166_user_io illustrates three alternative methods for using
global variables to interface the manually written driver functions with the
Real-Time Workshop automatically generated code. The three different
methods are illustrated by these signals:

® input_adcO
® output_PWMO
® output_led D3

For input_adcO, the variable is defined in the manually written code and
referenced in the Real-Time Workshop code.

For output_PWMO, the variable is defined in the Real-Time Workshop code and
referenced in the manually written code.

For output_led_ D3, a more sophisticated approach is used, involving custom
storage classes. In this case, the variable is again defined in the Real-Time
Workshop code and referenced by the manually written code; the difference
is that the variable is defined and referenced as a bitfield using C166
microcontroller bit-addressable memory:

1 Open the model c166_user_io.
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Dl

File Edit Yiew Simulation Format Tools Help

dEBEREs s l|1DD |N0rmal Y| B B &

~
R = =
Integrating Hand-Coded 1/Q Device Drivers
drive_signal 3 3
| measured_pozition Open ifo ‘_:"Ne'
saurce files
LED_D3
= pozition demand LED_DZ
output_digl _pa
gﬂ t 4 Open customn storage
cantroller output_dig class data file
‘| |_| |‘ <output_ UMD > Open help for
position demand integrating hand code
* ]
-
il Switch Target
Soope Configuration
measured_position drive_signal f«
plant model @
Copyright (c) 19942005 The Mathiods, Inc.
Ready [100es [ [ |ode4s .

input_adcO.

2 Open the controller subsystem by double-clicking and select the signal
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D c166_user_io,/ controller *
File Edit

Wigw Simulation Format  Tools Help

=10l x|

= = = e el IWINDrmaI 'I|@

position demand
2 l
: ¥
LintBE12) sy -,-:_{ 1. )
drive_signal_offset T drive_signal
input_adeD i e
measured_position EE B
&5
CAGE
clack = Resource
- autput_led_O0 L3 Canfiguration
Clack generator -
Clock generatart putput_dia
Ready [100% [ [ |odeds 4
3 Select the menu item Edit > Signal Properties.
The Signal Properties dialog box appears.
E! Signal Properties: input_adcO |

Signal name; Iinpul_ach

[ Signal name must resolve to Simulink signal object

Logging and acceszsibility | ::I::EeaI-Time Wwiarkshop:

Show propagated signalz I aff "I

Documentation I

RT' starage class: I ImportedE sterm

#

RTw starage type qualifier: I

Lancel Help

Apply
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Click the Real-Time Workshop tab and observe that the RTW storage
class is ImportedExtern. When you generate code for this model, the
specified variable name input_adcO is used, and an extern declaration is
created in the model header file. Since the Real-Time Workshop storage
class is ImportedExtern, this variable must be defined in the manually
written driver code. When you open the file user_io.c in the next step,
you will find the line uint16_T input_adcO that provides this definition.

4 In the top level model, double-click the link Open the i/o driver source

files.

Two source files open in the MATLAB editor, user_io.h and user_io.c.

File Edit Yiew Text Debug Breakpoints Web Window Help

Dedl sted- | a(asf|an|aaE EE| s« =X

1 s

2 * File: user_io.h

a4

4 * Ahstract:

) * Example file showing how to integrate hand-code input/output driver
i} * functions with Embedded Target for Infineon Cla6a6.
7 *

] * gRevision: 1.1 %

9 * gDhate: 2002/10/03 09:45:27 §

10 *

11 *

12

13| #include "twwtypes.h"

14

18| /*=====================s======================z==z===z==%
16 + Declare wariables that are imported by the model

17 f===s=====sz===s=sssssssssssssssssssssssssssssssssst)
18| extern uintlé T input_adel;

19

20| f*=====================%

1

b

ﬂ—’l user_ioh | user_io.c |

5 Click the user_io.h tab, as shown above. Here you can see extern
uint16_T input_adcO under the heading Declare variables that
are imported by the model. Also look at the #include directive in
user_io.c. The extern declaration and incorporating the header file into
the build makes it possible for the device driver functions to read or write
this variable that is defined in the Real-Time Workshop generated code.
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6 You need to instruct the Real-Time Workshop product to compile and link
the manually coded I/O driver source files in the build process. You do so
by adding the files to the custom code dialog box. Access the Configuration
Parameters dialog box, select Real-Time Workshop > Custom Code in
the tree, and review the Include Directories and Source Files, as shown in
the following figure.

"'%,, Configuration Parameters: c166_user_i

Select:

ELD

- E

|

olver

ata lmport/E xport
plimization
iagnostice

-~ Sample Time

- Data W alidity

- Type Conversion
- Connectivity

- Compatibility

- Model Referencing
- 5 aving

~Hardware [mplementation
- Wodel Referencing
-Real-Time Workshop

- Feport
- Comments
- Sumbols

- Diebug

- Interface

- Code Shyle

- Templates

- D ata Placement

- Memony Sections
- C166 Options (1]
mbedded [DE Link

- [Data Type Replace...

— Include custom c-code in generated:

Source file
Header file
Initialize function
Terminate function

‘Configuration (Active)

Source file:

b Ix

Include list of additional:

Include directonies
Source files
Libraries

Include directories:

"CAMATLAB  oolbox\rtwitargetsi\c 166V 166demasiuser_src”

9

0K I Lancel | Help

o

Apply |

7 Select C166 Options (1) (under Real-Time Workshop in the tree).
Observe the selected option Include input/output driver function

hoo

ks.
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E! Configuration Parameters: c166_user_io/Configuration |

Select; |

- Solver

- [ata Import/E sport
- 0 ptimization

[=- Diagnostics

i-Model R eferencing
- Hardware Implementation
- bl ndel Referencing
F-Real-Time Waorkshop
- Comments
- Symbols
- Custom Code
- Diebug
- |nterface
- Code Styule
- Templates
- [ata Flacement
- [ata Type Replace...
- b emony Sections
& _ 166 Opticns (1]
- Embedded IDE Link

¥ Include input/output driver function hooks

M aimum number of concunent baze-rate overuns: |5

I aimum number of concunent sub-rate overuns: |1

[~ Execution profiling

Murnber of data paintz: |00

|
1]8 I LCancel Help | Spply |

This instructs the Real-Time Workshop build process to include extra calls
to the user-supplied I/O device driver functions when code is generated for
this model.

Select Interface in the tree. Observe the option Floating-point numbers
is not selected.

If your model does not use floating point, you should make sure this option
is not checked to use integer code only. Using only integer code results in
smaller code size and faster real-time execution. It also speeds up the build
process because libraries that are used only by floating-point applications
are not included.
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Explore the user_io.c file. This example file is intended to show you
some manually coded input/output driver functions and how they can be
integrated with the Target Support Package product.

You can see sections for initializing these input/output drivers: ADC,
digital I/0, and Pulse Width Modulation (PWM).

9 Close the Signal Properties dialog box and Configuration Parameters
dialog box if they are still open.

Prior to generating code, you can run the model in closed-loop simulation;

just click Start Simulation ( 4 ) in the toolbar. You can open the

Scope block to see the model output. If you use this model as a basis

for integrating your own device driver code, this closed-loop simulation
allows you to validate the correct behavior of your control algorithm before
running it in real time.

10 Generate code by right-clicking the controller subsystem and selecting
Real-Time Workshop > Build Subsystem.

11 Click Build in the Build code for Subsystem: Controller dialog box that
appears. Watch the messages as the process proceeds and code is generated.

If you are using a Phytec phyCORE module with HD200 development
board, the digital output is connected to the LED D3. You can see successful
execution of the code when the LED blinks.
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Custom Storage Class
for C166 Microcontroller
Bit-Addressable Memory

This section contains the following topics:

® “Specifying C166 Microcontroller Bit-Addressable Memory” on page 4-2
e “Using the Bitfield Example Model” on page 4-3
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Specifying C166 Microcontroller Bit-Addressable Memory

Target Support Package allows you to take advantage of Infineon C166
microcontroller bit-addressable memory. The example model c166_bitfields
demonstrates this. By using bit-addressable memory, the compiler is able to
use special assembler instructions that significantly reduce code size and
increase execution speed.

Note This feature requires the Real-Time Workshop Embedded Coder
product.

This is done by using the custom storage class SimulinkC166.Signal. To
specify that a signal in the model should use bit-addressable memory, you
must perform the following steps:

1 Ensure that the signal has the Simulink data type 'boolean’.

2 Attach a label to the signal, either by using Edit > Signal Properties or
by double-clicking the signal and typing in the name directly; this label will
be used as the bitfield variable name in the generated code.

3 Create a new Simulink data object of type SimulinkC166.Signal with
the same name as the signal label. See the file c166bitfielddata.m for
an example.

4 Select View > Model Explorer and click the base workspace to inspect all
the Simulink data objects that are available to the model.

5 Build the model.

One of the signals in the demo model c166_user_io also uses the custom
storage class SimulinkC166.Signal to specify that the signal uses
bit-addressable memory. You can compare this with the c166_bitfields
example; it is included in the steps in “Using the Bitfield Example Model”
on page 4-3.
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Using the Bitfield Example Model

You can use the example model ¢c166_bitfields to see the automatic
debugger start at the end of the build.

Follow these steps:

1 Open c166_bitfields.

IZ1c166_bitfields

File Edit VYiew Simulation Format Tools  Help

=0l x|

DISE&S | sB2R|(Ec 4 (b sfiin0 [ome - ZHRDES @ REE@

C166 Bit-Addressable Memory

tempLimit Read docurnentation
<= for G166 hit-
®—|" addressable mermary
TEI'HFI AND =®
| ¥ Read documentation
tempCheckEnabled }—‘ ™ | (2 for custom
I_—l emp Slarm Latchiad storage classes
Latch Temperature
_—l_, - Inspect data ohjects
L4 1Y (3 Open setup file
h J
rpmCheckEnabled }J—’ T ]
| id Ill rpmAammLatched 4 Switch Target
Lateh Speed Configuration
Alarm
Lmns l
Copyright (c) 1994-2008 The b athiito s, Ine. ® 01';:; d

Fesource
Configuration

2 Press Ctrl+B to build the model.

3 Examine the project generated code in the TASKING EDE:

a Select Search > Multiple Sources.
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b In the dialog box, select Project Space under Multiple Sources, and enter
_bita for the search string.

J File Edit Search Project EBuld Text Document  Customize  Tools  Window  Help 18] =l
|[«-»-lasuasmaac]  -I#dée |voaEBRIET
=/ F#% user code (bottom of hedder file) #7 j

H:\. Al E7cs_hwhprojspace. psp 4% Bitfield data =/
typedef bita struct alarms tag |

projspace [3_P'_°iECtS] unsigned int tempAlarmlLatched:l;
2 c166_bitfields_c166 (9 __. unsigned int rymAlarmlLatched:1;

% c166_senial_tranzmit_c166 [... ! alarms bitfield;

[#-2y rhwlib [14 Files)

extern alarms bitfield alarms;

A% Bitfield data */
typedef bita struct control tag |
unsigned int rpwCheckEnabled:l;
unsigned int tenpCheckEnabled:l:
} control bitfield: J

extern control_bitfield control;

#endif /% _ETW HEADER c166 bitfields b #/

-
f% Wile dpailaw Faw Baal Time Tlawloles cevewarad —ods
L [ >

4 You can double-click Open setup file in the model to open the file
ci66bitfielddata.m in the MATLAB editor.
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File Edit Wew Text Debug Breakpoints “Web Window Help

DEHE| 2@ | S| #Ff

a@|@‘%l§ﬂ@@|stam|8359 I_I

1 l‘% ClogBITFIELDDATA create data for ClE6 bitfield demo model
2
3 % Copyright 2002 The MathWorks, Inc.
4 % $(Revision: 1.1 §
&5 % fhate: Z00Z/10/03 09:45:24 ¢
3}
7= cacdenoclearws
g
2] temphlarm = JimulinkCles. Signal;
10| - temphlarm. RTWInfo. Custombdttributes. BitFieldNane = 'alarms';
11
12— temphlarmlatched = 3imulinkCl66. 3ignal;
13— temphlarmlatched. FTWInfo. Custondttributes . EitFieldName = 'alarms';
14
15— rpmilarm = SimulinkCle6.3ignal;
16| - rpmilarm, RTWInfo. Custonhttributes. . BitFieldNane = 'alarms';
17
18| - rpmélarmLatched = SimulinkCl66.3icnal:
18— rpumédlarnLatched. RTWInfo. Custondttributes. BicFieldane = 'alarms';
20
21— templimit = wintlé (500
1

pr

This file creates a new Simulink data object using the custom storage class
SimulinkC166.Signal. By using custom storage classes, you can collect
a number of input or output variables together into a C struct, resulting
in more readable code. By defining your own custom storage classes, you

have complete control over the data structures that are used for any
signal in the model. See the custom storage class documentation in the

Real-Time Workshop Embedded Coder User’s Guide for more details. You
can double-click Read documentation for custom storage classes in
the model to go directly to the relevant Real-Time Workshop Embedded

Coder help section.

5 You can double-click Inspect data objects to inspect all the Simulink

data objects that are available to the model.
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F& Model Explorer =10l x|
File Edit Yiew Tools Add Help

D imeax BHEWHFO Dn 40|t waazq

JJSearch: Ib_l,l Block Type LI Type: IEonstanﬂ ;I Search
Model Hierarchy Contents of: Base ‘Workzpace Base Workspace
E--@Simulink Roat | M ame I DataType | W alue Caomplexity Dimensionsl Minl MaHl StorageClass | The base [MATLAB] work:
- B Base Workspacs £ output_dig] auto auto 3 It ot CIGEBField (Custam) || Jonanies that are visiie to
L ese varables can be ugs
8166 _serial_transmit £ output_led_D3 auta auto 1 Anf Inf  CIBBBifField [Custom] || cettain madel, block and s
o186 _user io - prélamlatched  auto auto 1 Inf Inf  C1BBRitField [Custom)
- W T86._bifelds € templamlatched  auto auto 1 Inf Inf C1EGBitField [Custom)
H headerText <1x52 chary
B rprlimit 500
H tempLimit h00
[i%i] ipmCheckEnabled true Anf Inf C16BBitField (Custam)
[5,\}1] tempCheckEnabled true Anf Imf C1BEBitField (Custom)
d | 2
«| | || Contents | Search Results I Bzt | el

A

Here you can see the SimulinkC166.Signal data object and you can click
on each object to inspect the properties.

6 One of the signals in the demo model c166_user_io also uses the custom
storage class SimulinkC166.Signal to specify that the signal uses
bit-addressable memory. Open c166_user_io.

7 Double-click Open custom storage class data file.

The file c166useriodata.m opens in the MATLAB editor.
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File Edit Wiew Text Debug Breakpoints “Web ‘Window Help

DEH 2@ S HAf | 88 BDERE| s -] x
1 % CleoUSERIODATA create data for Cleg user ido dewo model 1=
2
3 % Copyright 2002 The MathWorks, Inc.

4 % t(Revision: 1.2 &

& % Fhate: 2002710409 11:14:05 3

3}

7= output_led D3 = SimulinkCle6.Signal;

8- output_led D3.RTWInfo.Customittributes.BitFieldNane = 'dig outputs';
9

10— output_digl = SimulinkCl66.3ignal;

11— output_digl.RTWInfo. Custondttributes.BitFieldNane = 'dig_outputs':

12
13

|
1 [
'] c166hitfielddata.m ¢l BEUserindata.m |

Compare with c166bitfielddata.m.

For more details on the variables in this model, see “Tutorial: Using the

Example Driver Functions” on page 3-11.
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Execution Profiling

This section contains the following topics:

® “Overview of Execution Profiling” on page 5-2

¢ “Real-Time Workshop Options for Execution Profiling” on page 5-6
e “Multitasking Demo Model” on page 5-10
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Overview of Execution Profiling

In this section...

“Introducing Execution Profiling” on page 5-2
“The Profiling Command” on page 5-3
“Definitions” on page 5-5

“Execution Profiling Blocks” on page 5-5

Introducing Execution Profiling

The Target Support Package product provides a set of utilities for recording,
uploading, and analyzing execution profile data for timer-based tasks and
asynchronous Interrupt Service Routines (ISRs). With these utilities, you can

® Generate a graphical display that shows when timer-based tasks and
Interrupt service routines are activated, preempted, resumed, and
completed.

® Generate a report with information on

Maximum number of overruns for each timer-based task since model
execution began

Maximum turnaround time for each timer-based task since model
execution began

Analysis of profiling data for timer-based tasks and asynchronous

interrupts over a period of time

To perform execution-profiling analysis on a model, you must perform the
following steps:
1 Place a copy of the appropriate execution profiling block in your model:
¢ Execution Profiling via ASCO if using a serial connection
¢ Execution Profiling via CAN A if using CAN with a C166 processor

¢ Execution Profiling via TwinCAN A if using CAN with an XC16x
processor variant

5-2
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2 Select the Execution profiling option under Real-Time Workshop
options in the Configuration Parameters dialog box. See “Real-Time
Workshop Options for Execution Profiling” on page 5-6.

3 Connect the target processor to your host PC (with a serial or CAN cable).
4 Build, download, and run the model.

5 Initiate execution profiling by running the command profile c166. See
below for more information on the profiling command.

Two forms of execution profiling are provided:

1 The worst-case values for task turnaround times and number of concurrent
task overruns since model execution began are updated whenever a
previous worst-case value is exceeded.

2 A snapshot of task and ISR activity may be recorded over a period of time;
the length of this period depends on how much memory is reserved to log
the data.

The Profiling Command

Use the profiling command as follows:

profile c166(connection)

Specify your connection as 'can' or 'serial’, to collect data via a CAN
or serial connection between the target and the host computer. Make sure
the model includes the appropriate C166 execution profiling block (CAN or
ASCO0), to provide an interface between the target-side profiling engine and
the host-side computer from which this command is run.

PROFDATA = profile c166(connection) collects and displays execution
profiling data from a C166 target microcontroller that is running a suitably
configured application generated by the Target Support Package product.
PROFDATA contains the execution profiling data in the format documented
by exprofile_ unpack.

The data collected is unpacked then displayed in a summary HTML report
and as a MATLAB graphic.
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To use the serial connection, the C166 board must be connected via a serial
cable to one of the host computer’s serial ports. This function defaults to port
ASCO on the C166 and port COM1 on the host computer. If the 'BitRate’
argument is not provided, the default of 57600 baud is used.

PROFDATA = PROFILE_C166('serial', 'SerialPort',serialport)

sets the serial port to the specified serialport, which should be one of COM1,
COM2, etc.

Optionally, you can specify the bit rate as follows:

PROFDATA = PROFILE_C166('serial', 'BitRate', bitrate)

This specification sets the bitrate for serial connection to the target. bitrate
must be the same as the bit rate specified for the application that is running
on the target.

Alternatively, you can set the bitrate for the serial connection to the target
automatically as follows:

profdata = profile_c166( 'serial', 'ModelName', modelname)

This specification automatically sets the bit rate by analyzing modelname
and extracting the correct serial connection bit rate setting from the model.
modelname should be set to the name of a model which is currently open and
running on the target.

To use the CAN connection, you must have suitable CAN hardware installed.
If no Application Channel is specified, this function will use the channel
'"MATLAB 1'. The bit rate is a property of the Application Channel; to change
the bit rate, you must use a different Application Channel, or change the

bit rate by running the Vector Informatik configuration utility. To run this
utility, make sure that vcanconf.exe is on your System Path, then type
vcanconf from a Windows command prompt.

You can specify the Application Channel as follows:

profdata = profile_c166('can', 'CANChannel', canchannel)
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canchannel specifies the Vector Informatik CAN Application Channel, and
must be of the form 'MATLAB 1', 'MATLAB 2' etc.

Definitions

Task turnaround time is the elapsed time between start and finish of a
task. If the task is not preempted, then the task turnaround time is equal
to the task execution time.

Task execution time is that part of the time between task start and finish
when the task is actually running and not preempted by another task. Note
that the task execution time cannot be measured directly, but is inferred from
the task start and finish time and the intervening periods during which it was
preempted by another task. Note that, in performing these calculations, no
account is taken of processor time consumed by the scheduler while switching
tasks: this means that, in cases where preemption has occurred, the reported
task execution times will overestimate the true values.

Concurrent task overruns occur when a timer task does not complete
before that same task is next scheduled to run. Depending on how the
real-time scheduler is configured, a task overrun may be handled as a
real-time failure. Alternatively, a small number of concurrent task overruns
may be allowed to accommodate cases where a task occasionally takes longer
than normal to complete.

Execution Profiling Blocks

See the block reference sections:

® (C166 Execution Profiling via ASCO
¢ (C166 Execution Profiling via CAN A
® (C166 Execution Profiling via TwinCAN A
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Real-Time Workshop Options for Execution Profiling
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In this section...

“Execution Profiling” on page 5-6

“Number of Data Points” on page 5-7

“Task Scheduler Overrun Options” on page 5-7

Execution Profiling

You can see the options for execution profiling by selecting C166 Options (1)
(under Real-Time Workshop in the tree) in the Configuration Parameters
dialog box.

*"é; Configuration Parameters: c166_multitasking/Configuration {Active)

Select: |

™ Inchude input/output diver function hooks
- Solver

- [ ata lmport/E =port I awimum number of concurent base-rate overmuns: I 5

- [ ptimization
- Diagnostics
- Sample Time

I awimum number of concurent sub-rate overung: I 1]

™ Execution profiing

- [ ata W alidity

. Type Conversion Mumber of data paints: | 500

- Connectivity

- Compatibility

- Model Referencing
- Saving

ardware Implementation
odel Referencing
eal-Time Workshop

- Report

- Commernts

- Symbols

- Cugtom Code

- Debug

- Interface

- Code Style

- Templates

- Data Placement

- Data Type Replace. ..
- Memony Sections

e

--Embedded IDE Link

@ il

Lancel | Help | Lpply

b |x

=l
|

If the Execution Profiling option is selected, then the generated code for
the model will be “instrumented” with function calls at the beginning and
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end of each task or ISR to be profiled. These function calls read a timer (on
C166 a free running timer is selected from the options in the C166 Resource
Configuration block) and log this reading along with a task identifier.

When code for the model is generated, these functions will update data

on the worst-case turnaround time for each timer-based task as well as

the worst-case number of concurrent task overruns, whenever a previous
worst-case value is exceeded. Additionally, when a trigger is provided, data
will be logged over a period of time to record all task start and finish times.
The trigger signal can be supplied, for example, by the block C166 Execution
Profiling via CAN A.

Number of Data Points

When a snapshot of task and ISR activity is logged, this data is stored in
memory that is statically allocated at build time. Each data point requires 4
bytes on C166. The larger the number of data points to be stored, the more
RAM that must be reserved for this purpose. At the end of a logging run, the
data must be uploaded to the host computer for analysis; this is typically
achieved by using one of the C166 execution profiling blocks — via ASCO,
CAN A, or TwinCAN A. See the reference pages for C166 Execution Profiling
via ASCO, C166 Execution Profiling via CAN A, and C166 Execution Profiling
via TwinCAN A.

Task Scheduler Overrun Options

These scheduler options configure the allowable number of concurrent task
overruns. You can see these options on the C166 Options (1) section in the
Configuration Parameters dialog box.
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You can use the options Maximum number of concurrent base-rate
overruns and Maximum number of concurrent sub-rate overruns to
configure the behavior of the scheduler when any of the timer based tasks do
not complete within their allowed sample time. It is useful to allow task
overruns in the case where a task may occasionally take longer than usual to
complete (e.g., if extra processing is required when a special event occurs);

if the task overrun is only occasional, then it is possible for the scheduler to
catch up after the extra processing has been completed.

If the maximum number of concurrent overruns for any task is exceeded, this
is deemed to be a failure and the real-time application is stopped.

As an example, if the base rate is 1 ms and the maximum number of
concurrent base-rate overruns is set to 5 then it is possible for the base rate
task to run for almost 6 ms before failure occurs. Once the overrun has
occurred, it is necessary for subsequent executions of the base rate to complete
in less than 1 ms in order that the lost time is recovered.




Real-Time Workshop® Options for Execution Profiling

The occurrence of base-rate overruns does not affect the numerical behavior
of the algorithm (although reading/writing external devices will of course
be delayed).

If sub-rate overruns are allowed, then the transfer of data between different
rates (via rate-transition blocks) in the model may be affected; this

causes the numerical behavior in real time to differ from the behavior in
simulation. To see an illustration of this effect, try running the demo model
c166_multitasking, described in the next section. To disallow sub-rate
overruns and ensure that this effect does not occur, you should set Maximum
number of concurrent sub-rate overruns to zero.

Note Allowing sub-rate overruns may cause non-determinism and loss of
integrity for data transferred between different rates in the model. Set this
value to zero if you require sub-rate overruns to be handled as a failure
(recommended).

If you allow sub-rate overruns, then the behavior of any Rate-Transition
blocks may be affected. Specifically, if the model contains a Rate Transition
block where the option "Ensure deterministic data transfer (maximum delay)"
1s selected, then this setting may not be honored.
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In this section...

“Introducing the Multitasking Demo” on page 5-10
“Running the Multitasking Demo” on page 5-11
“Interpreting the MATLAB Graphic” on page 5-13
“The Generated HTML Report” on page 5-14

Introducing the Multitasking Demo

The demo model c166_multitasking illustrates both execution profiling and
the preemptive multitasking scheduler with configurable overrun handling.

The model is multirate, having tasks running at 1 ms, 4 ms, and 16 ms. It is
configured to use the preemptive multitasking scheduler.

A special feature of this model is that each task is designed to perform an
increasing number of calculations to increase the processor loading until
that task reaches a target turnaround time. This behavior ensures that task
overruns occur to demonstrate the behavior of the model in this situation.

Each block in the model, labeled Load base rate, Load sub-rate 1, Load
sub-rate 2 performs calculations, the result of which should always be 1
both in simulation and in real time. Any other result is a failure and should
never occur.

The Test Rate Interaction blocks are designed to test whether data is
transferred between tasks in a deterministic manner. In simulation, the
output of each of these blocks is always zero, indicating that there is no drift
between tasks running at different rates. When running in real time, under
normal circumstances, the output is also zero; in this case the real-time
behavior is deterministic and exactly matches the results in simulation. Even
if task preemption and base-rate overruns occur, the output of these blocks
will be zero so that the real-time behavior faithfully reproduces the results
in simulation. The circumstance under which drift occurs is if sub-rate
overruns occur during execution in real time; if this behavior is not desired,
you should disallow sub-rate overruns by setting the maximum allowed
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number of sub-rate overruns to zero in the C166 Options (1) section in the
Configuration Parameters dialog box (see “Task Scheduler Overrun Options”

on page 5-7).

You can double-click the block provided in the model to switch between
profiling over serial or CAN connections.

Running the Multitasking Demo

1 Open the model by typing at the command line

c166_multitasking

If viewing in the Help browser, you can click the link to open the model. If
you update the diagram you can see the sample-time colors.

1166 _multitasking *
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=18l =]
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Fresut ok | B22lE2N
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Load sub-rate 1

boslean

Result ok
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Canfiguration

L Task 1 Resuit

Result ok |- g Tazk  Result

CAN_MESBARE_BIRENFED

—— - Task 3 Resut -
ask ¥ R # Transmit

CAN bsg

Drit base-rate to sub-rate 1 CAN Transmit
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Load sub-rate 2

Switch Target
Configuration

©

Updating

Execution Prafiling Switeh Execution
wia Serial Frafiling Connection

Copyright 1984-2006 The Mathioiks, Inc.

[100% |FixedstepDiscrete

2 Select Simulation > Configuration Parameters.

The Configuration Parameters dialog box appears.
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3 Select Embedded IDE Link in the tree and change the Build action to
Create, Build and Execute Application Project. Click OK to dismiss
the dialog box.

4 Make sure the target is connected to the host PC via serial or CAN cable.
The default setting in this demo model is serial. You can double-click the
Switch Execution Profiling Connection block to toggle between blocks for
serial and CAN. See below for instructions if using CAN.

5 To build and run the model, select the model window, and then press
Ctrl+B.

Watch the messages in the command window as code is generated and
loaded into the TASKING EDE, then the CrossView Pro Debugger starts,
connects to the target, and downloads the code.

6 In the CrossView window, click Run in the toolbar to start the application
running on the target.

7 At the command line, type
profile c166 ('serial')
You will see messages in the command window as profile c166 runs.

When the data has been obtained the Help browser and a figure window
appear, displaying the HTML report and the task execution profile.

8 Scroll to view the HTML report on task timings and use the controls to zoom
in on the MATLAB graphic to examine the details of the task overruns.

If using CAN, be sure to use CAN channel 0 (not 1) on the PC. You can
double-click the Switch Execution Profiling Connection block in the model to
switch to CAN, and follow the same instructions as for a serial connection,
except step 7 when the application is running. At the command line, type

profile _c166 ('CAN')

You will see command line messages as the function tests the CAN channel,
and requests and collects profiling data. When using CAN, it can be useful to
run a monitor program such as btest32 to verify that the model is running —
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for example you will see messages appearing on the CAN bus and you can see
that you have connected the correct CAN channel.

Interpreting the MATLAB Graphic

Dark shaded areas show the region where a task is executing. Light shaded
areas show the region where a task is preempted by a higher priority task
or ISR. Triangles indicate the beginning of a task. An example is shown
following.

Bl Figure 1 B|=]%]

File Edit “iew Inzert Toolz Deskiop Window Help ]

T EINEEY R

Task Execution Profile

all JN} \W |H HH“ """"

Sub-Rate 1}

Ease-Rate |l 0 S A0 0 R ot AR il

0 po2 o004 OO OO 01 012 014 0168 018 0.2
Time in seconds

Zoom in to see the details of times that tasks are executing and being
preempted, as shown in the following example.
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B Figure 1 [BEx]
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The Generated HTML Report

See “Definitions” on page 5-5 for the terms task turnaround time, task
execution time, and concurrent task overruns.

All times are in seconds. The timer resolution is 4e-007 seconds and the
measurement range is 0.026214 seconds.

The report contains the following information:

e Worst-case task turnaround times
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= Maximum task turnaround time for each task since model execution
started. Note that the maximum task turnaround time that can be
measured 1s limited by the timer measurement range.

¢ Maximum number of overruns for each task

= Maximum number of concurrent task overruns since model execution
started

® Analysis of recorded profiling data

= Analysis of task turnaround times and task execution times based on
recorded data over a period of 0.18139 second

Examples are shown following.
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% RTW Report - Execution Profile Results 10l x|

File Edit Wiew Go Debug Desktop ‘Window Help

Model Execution Profiling Results

* YWorst case task turnaround times
o Maxirum number of concurrent overruns for each task
* Analysis of recorded profiling data

All tirnes are in seconds. The timer resolution is 1.6e-006 seconds and the measurement range is 010486 seconds.

Worst case task turnaround times

faximum task turnaround time for each task since model execution started. The task turnaround time is continually updated from the time when
rnodel execution began; the value is only allowed to increase and therefore records the maximum task turnaround time which is the worst case.
Mate that the maximum task turnaround time that can be measured is limited by the timer measurement range. This may affect the results, for
example, if the timer word-size is only 8 or 16 bits and if the sub-rate sample times are much longer than the base sample time.

Task Maximum turnaround time

Base-Rate |0.000507

Sub-Rate 1 | 5.76e-005

Maximum number of concurrent overruns for each task

faximum number of concurrent task averruns since model execution started.

Task Maximum number of task overruns
Base-Rate |0
Sub-Rate 1 |0

|»
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%YRTW Report - Execution Profile Results

File Edit Wiew Go Debug Desktop ‘Window Help

Analysis of profiling data recorded over 1.6695 seconds.

Profiling data was recorded over 1.6695 seconds. The recorded data for task turnaround times and task execution times is presented in the table

below.
Task Maximum turnaround Average turnaround Maximum execution Average execution Average sample
time time time time time
Base Rate |0.000452 at 1.03 0.000452 0.000462 &t 1.03 0.000462 0.0
Sub-Rate 1 | 2.24e-005 at 1.14 2.24e-005 2248005 at 1.14 2242005 ooz

Task turnaround time is the elapsed time between start and finish of the task. If the task is not pre-empted then the task turnaround time is egual
to the task execution time.

Task execution time is that part of the time between task start and finish when the task is actually running and not pre-empted by another task.
Mate that the task execution time cannot be measured directly, but is inferred from the task start and finish time and the intervening periods during
which it was preempted by another task. Mote that, in performing these calculations, no account is taken of processor time consumed by the
scheduler while switching tasks: this means that, in cases where preemption has occurred, the reported task execution times will overestimate the
true values.

Task overruns occur when a timer task does not complete before that same task is next scheduled to run. Depending on how the reaktime
scheduler is configured, a task overrun may be handled as a realtime failure. Alternatively, a small number of task overruns may be allowed in order
to accommodate cases where a task occasionally takes longer than normal to complete. If a task overrun has occurred and the same task is again
scheduled to run before the first overrun has been cleared then two concurrent task overruns are said to have occurred.
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Block Reference

C166 Drivers (p. 6-2)

CAN Message Blocks and CAN
Drivers (p. 6-6)

Target Support Package
device driver blocks

Blocks that provide CAN
functionality
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C166 Drivers
Top-Level Blocks (p. 6-2)
Asynchronous/Synchronous Serial
Interface (p. 6-2)
CAN Interface (p. 6-3)
C-CAN Interface (p. 6-3)
Execution Profiling (p. 6-4)
TwinCAN Interface (p. 6-4)
Interrupts (p. 6-5)

Utilities (p. 6-5)

Digital Input/Output (p. 6-5)

Top-Level Blocks

C166 Resource Configuration

Resource configuration for C166
microcontrollers

Serial transmit and receive

Controller Area Network (CAN)
utilities

Controller Area Network (CAN)
utilities for C-CAN

Configure execution profiling over
CAN, TwinCAN, or serial connection

Controller Area Network (CAN)
utilities for XC16x

Generate function-call triggers on
interrupt

Configure for predefined hardware
configurations

Configure digital input/output

Support device configuration for
Infineon C166 microcontrollers

Asynchronous/Synchronous Serial Interface

Serial Receive

Serial Transmit

Configure C166 microcontroller for
serial receive

Configure Infineon C166
microcontroller for serial transmit



C166 Drivers

CAN Interface

CAN Bus Status

CAN Calibration Protocol (C166)

CAN Receive

CAN Reset
CAN Transmit

Output Bus Off or Error Warning
state of CAN module

Implement CAN Calibration Protocol
(CCP) standard

Receive CAN messages from
CAN module on Infineon C166
microcontrollers

Reset CAN module

Transmit CAN messages via
CAN module on Infineon C166
microcontrollers

For information about CAN message blocks and CAN drivers, see “CAN
Message Blocks and CAN Drivers” on page 6-6.

C-CAN Interface

C-CAN Receive
C-CAN Transmit

CAN Calibration Protocol (C166,
C-CAN)

Receive CAN messages from C-CAN
module on ST10 microcontrollers

Transmit CAN messages via C-CAN
module on ST10 microcontrollers

Implement CAN Calibration Protocol
(CCP) standard with C-CAN

For information about CAN message blocks and CAN drivers, see “CAN
Message Blocks and CAN Drivers” on page 6-6.
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Execution Profiling

C166 Execution Profiling via ASCO

C166 Execution Profiling via C-CAN
1

C166 Execution Profiling via CAN A

C166 Execution Profiling via
TwinCAN A

TwinCAN Interface

CAN Calibration Protocol (C166,
TwinCAN)

TwinCAN Bus Status
TwinCAN Receive

TwinCAN Reset

TwinCAN Transmit

Provide serial interface to execution
profiling engine

Provide CAN interface to execution
profiling engine via C-CAN channel
1 on ST10 microcontrollers

Provide CAN interface to execution
profiling engine via CAN channel A

Provide CAN interface to execution
profiling engine via TwinCAN
channel A for XC16x variants of
Infineon C166 microcontrollers

Implement CAN Calibration Protocol
(CCP) standard for XC16x variants
of Infineon C166 microcontrollers

Output Bus Off or Error Warning
state of a CAN node on XC16x
variants of Infineon C166
microcontrollers

Receive CAN messages via TwinCAN
module on XC16x variants of
Infineon C166 microcontrollers

Reset CAN node on XC16x variants
of Infineon C166 microcontrollers

Transmit CAN messages from
TwinCAN module on XC16x variants
of Infineon C166 microcontrollers



C166 Drivers

Interrupts
Fast External Interrupt Generate asynchronous function-call
trigger when interrupt occurs
Utilities

Switch External Mode Configuration Configure model for external mode
or executable building

Switch Target Configuration Configure model and Target
Preferences to one of a set of
predefined hardware configurations

Digital Input/Output

Digital In Digital input driver that reads value
of specified port or pin number

Digital Out Digital output driver that sets logical
state of specified pin
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CAN Message Blocks and CAN Drivers

CAN Pack Pack individual signals into CAN
message

CAN Unpack Unpack individual signals from CAN
messages

For information about obsolete CAN message blocks and CAN drivers, see
CAN Blocks Transition.
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C166 Execution Profiling via ASCO

Purpose

Library

Description

Execution Profiling
via Serial

C1G6 Execution Profiling
wia ASCO

Provide serial interface to execution profiling engine

Target Support Package/ Supported Processors/ Infineon C166/
Execution Profiling

The C166 Execution Profiling via ASCO block provides a serial interface
to the execution profiling engine. On receipt of a start command
message, logging of execution profile data begins. On completion of a
logging run, the recorded data is automatically returned via the serial
interface (ASCO0). See also the MATLAB command profile c166.

profile c166('serial') collects and displays execution profiling
data from an InfineonC166 target microcontroller that is running

a suitably configured application generated by the Target Support
Package product.

The data collected is unpacked and then displayed in a summary HTML
report and as a MATLAB graphic.

See “The Profiling Command” on page 5-3 for instructions for setting
the bit rate automatically or manually, and setting the serial port.

To configure a model for use with execution profiling, you must perform
the following steps:

1 Check the appropriate option in the Target Specific Options tab of
the Real-Time Workshop Options dialog box.

2 Make sure the model includes a C166 Execution Profiling block that
provides an interface between the target-side profiling engine, and
the host-side computer from which this command is run.

For more information, see Chapter 5, “Execution Profiling” which
includes instructions for the example demo ¢166_multitasking.



C166 Execution Profiling via ASCO
|

DIGIOg m Block Parameters: C166 Execution Profiling ¥ia ed

Box —C166 Ewxecution Profiling via Senal Port A5C0 [mazk] [link]

Frovides a zernial interface to the execution profiing engine. On receipt of a start
cammand ta the serial part, lagaing of execution prafile data is commenced. On
completion of a logging run, the recorded data iz autamatically returned via zerial.

Mo ather zenal Blocks may be uzed in the model if an Execution Prafiling wia Serial
block iz prezent.

See alzo MATLAR command prafile_c1BE.

— Parameters

Sample time:

i

ok LCancel Help Apply

Sample time
The sample time of the block. The faster the sample time of the
block, the faster data will be uploaded at the end of the execution
profiling run. You may want to run this block slower than the
fastest rate in the system because the execution profiling itself
imposes some loading on the processor. You can minimize this
extra loading by not running it at the fastest rate.
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Purpose

Library

Description

Execution
Frofiling

C1G6 Execution Profiling
wia CAN A

Provide CAN interface to execution profiling engine via CAN channel A

Target Support Package/ Supported Processors/ Infineon C166/
Execution Profiling

The C166 Execution Profiling via CAN A block provides a CAN interface
to the execution profiling engine. On receipt of a start command
message, logging of execution profile data begins. On completion of a
logging run, the recorded data is automatically returned via CAN. You
must specify the message identifiers for the start command and the
returned data. These identifiers must be compatible with the values
used by the host-side part of the execution profiling utility. See also the
MATLAB command profile c166.

profile c166(CAN) collects and displays execution profiling data from
an Infineon C166 target microcontroller that is running a suitably
configured application generated by the Target Support Package
product. The data collected is unpacked then displayed in a summary
HTML report and as a MATLAB graphic.

To use the CAN connection, you must have suitable CAN hardware
installed on the host computer. See “The Profiling Command” on page
5-3 for instructions for setting the CAN Application Channel and bit
rate.

To configure a model for use with execution profiling, you must perform
the following steps:

1 Check the appropriate option in the Target Specific Options tab of
the Real-Time Workshop Options dialog box.

2 Make sure the model includes a C166 Execution Profiling block that
provides an interface between the target-side profiling engine, and
the host-side computer from which this command is run.

For more information, see Chapter 5, “Execution Profiling” which
includes instructions for the example demo ¢166_multitasking.



C166 Execution Profiling via CAN A
|

D|°|°9 Block Parameters: C166 Execution Profiling #]

Box — C1BE Execution Profiling wia CAM Channel & [mazk] [link]

Providez a CAM interface to the execution profiing engine. On receipt of a
gtart command meszage, logaging of execution profile data i commenced.
On completion of a lagaing rwn, the recorded data iz autamatically
returned via CAR.

Y'ou must specify the meszage identifiers far the start command and the
returned data, These identifiers must be compatible with the values uzed
by the host-zide part of the execution profiling utility. See also MATLAE
cammand prafile_c16E.

— Parameters
Start command CAM meszage identifier:

hex2dec]1FFFFFOO')

R eturned data CAM meszzage identifier:
|he:-:2|:|e-:['1 FFFFFO1Y

Sample tirme;

|1
] I Cancel Help Spply

Start command CAN message identifier
Set the identifier of the message to start logging execution
profiling data. You should use the default unless you have
modified profile c166. This identifier must be compatible with
the values used by the host-side part of the execution profiling
utility (profile c166).

The utility profile c166 provides a mechanism for initiating
an execution profiling run and for uploading the recorded data
to the host machine. To perform this procedure using a CAN
connection between host and target, profile c166 first sends a
CAN message that is a command to start an execution profiling
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run. The CAN identifier for this message must be specified as the
same value on the target as on the host. The host-side values
are hard-coded in profile c166. If you are using an unmodified
version of the host-side utility, you should use the default value
for this CAN message identifier. These are visible to help you
avoid using the same identifier for other tasks.

Returned data CAN message identifier

Set the message identifier for the returned data. As with the
message identifier for the start command, the value specified here
must be the same as the hard-coded value in profile c166.

Sample time

The sample time of the block. The faster the sample time of the
block, the faster data will be uploaded at the end of the execution
profiling run. You may want to run this block slower than the
fastest rate in the system because the execution profiling itself
imposes some loading on the processor. You can minimize this
extra loading by not running it at the fastest rate.



C166 Execution Profiling via C-CAN 1

Purpose Provide CAN interface to execution profiling engine via C-CAN channel
1 on ST10 microcontrollers

Librclry Target Support Package/ Supported Processors/ Infineon C166/
Execution Profiling

Description

Execution Profiling
wia CAN

CA66 Execution Profiling
wia C-CAM 1

The C166 Execution Profiling via C-CAN 1 block is for the C-CAN
interface and performs the same functions as the C166 Execution
Profiling via CAN A block. For block parameter descriptions, see the
C166 Execution Profiling via CAN A reference page.
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Purpose
Library

Description

Provide CAN interface to execution profiling engine via TwinCAN
channel A for XC16x variants of Infineon C166 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/
Execution Profiling

The C166 Execution Profiling via TwinCAN A block is for the TwinCAN
interface and performs the same functions as the C166 Execution
Profiling via CAN A block. For block parameter descriptions, see the
C166 Execution Profiling via CAN A reference page.



C166 Resource Configuration

Purpose
Library

Description

Support device configuration for Infineon C166 microcontrollers
Target Support Package/ Supported Processors/ Infineon C166

The C166 Resource Configuration block differs in function and behavior
from conventional blocks. Therefore, we refer to this block as the C166
Resource Configuration object.

The C166 Resource Configuration object is required to provide
information that is used to configure driver blocks and timer interrupts.

® You must include this block in your model if

= You are using any of the driver blocks supplied with the Target
Support Package product

= You are taking advantage of the automatically generated scheduler
that is driven by timer interrupts.

® You do not need to include the C166 Resource Configuration object in
your model if you are not using any of the C166 driver library blocks,
and if you do not require the automatically generated scheduler (for
example, if you are supplying your own main.c).

The C166 Resource Configuration object maintains configuration
settings that apply to the Infineon C166 microcontroller. Although the
C166 Resource Configuration object resembles a conventional block in
appearance, it is not connected to other blocks via input or output ports.
This is because the purpose of the C166 Resource Configuration object is
to provide information to other blocks in the model. C166 device driver
blocks register their presence with the C166 Resource Configuration
object when they are added to a model or subsystem; they can then
query the C166 Resource Configuration object for required information.

To install a C166 Resource Configuration object in a model or
subsystem, open the C166 Drivers library and select the C166 Resource
Configuration icon. Then drag and drop it into your model or subsystem,
like a conventional block.
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Having installed a C166 Resource Configuration object into your model
or subsystem, you can then select and edit configuration settings in the
C166 Resource Configuration window. See “Using the C166 Resource
Configuration Window” on page 7-12 for further information.

Note If your model or subsystem requires a C166 Resource
Configuration object (see above), you should place it at the top-level
system for which you are going to generate code. If your whole

model is going to run on the target processor, put the C166 Resource
Configuration object at the root level of the model. If you are going to
generate code from separate subsystems (to run specific subsystems on
the target), place a C166 Resource Configuration object at the top level
of each subsystem. You should not have more than one C166 Resource
Configuration object in the same branch of the model hierarchy. Errors
will result if these conditions are not met.

When the C166 Resource Configuration block is placed into a model,
it modifies the preloadfcn callback of the model. If you wish to add
a command to the preloadfcn callback of a model that already has
an C166 Resource Configuration block, do not remove the commands
that are already installed. Instead, copy the installed preloadfcn
callback and append your commands. Then set the preloadfcn

to the merged command. If you corrupt the preloadfcn, you can
retrieve the command from any model that has a C166 Resource
Configuration block, as the preloadfcn will be the same for all models.
You can retrieve the preloadfcn with the following command: plf =
get_param(bdroot, 'preloadfcn')

Types of Configurations

A configuration is a collection of parameter values affecting the
operation of one or more device driver blocks in the Target Support
Package library. The C166 Resource Configuration object currently
supports the following types of configurations:
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Dialog
Box

e “C166 System Configuration Parameters” on page 7-14
(c166drivers): C166 microcontroller clocks and other CPU-related
parameters

® “Asynchronous/Synchronous Serial Interface Configuration
Parameters” on page 7-16Asynchronous/Synchronous Serial Interface
Configuration: parameters related to the serial driver blocks and
Simulink external mode

® “CAN Configuration Parameters” on page 7-18: parameters for CAN
interrupt levels

e “TwinCAN Configuration Parameters” on page 7-21: parameters for
TwinCAN interrupt levels

e “C-CAN Configuration Parameters” on page 7-22: parameters for
C-CAN interrupt levels

The C166 drivers configuration always appears in the active
configuration pane. If there are also blocks in your model from the
Asynchronous/Synchronous Serial Interface (ASCO) sublibrary, you
will also see the configuration for these, as seen in the next example.

If you add an ASCO block to a model without any ASCO blocks, the
appropriate configuration is created and activated in the C166 Resource
Configuration block. Similarly, if you add CAN blocks to a model, a
CAN configuration is created.

You can see an example like this by opening the demo model
c166_serial_transmit and double-clicking on the C166 Resource
Configuration block.

A configuration remains active until all blocks associated with it are
removed from the model or subsystem. At that point, the configuration
is in an inactive state. Inactive configurations are lost from the C166
Resource Configuration window when the model is saved and reopened.
You can reactivate a configuration by simply adding an appropriate
block into the model.
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Using the C166 Resource Configuration Window

To open the C166 Resource Configuration window, install a C166
Resource Configuration object in your model or subsystem and
double-click on the C166 Resource Configuration icon. The C166
Resource Configuration window then opens.

This example shows the C166 Resource Configuration window for a
model that has active configurations for the C166 microcontroller
(c166drivers) and for the Asynchronous/Synchronous Serial Interface
(ASCO) blocks, as found in the demo c166_serial transmit.

=
Syatetn Configuration |
; External_oscillator_frequency a000000.0
1 BEdriversiAzynchronousiSynchronous Serial Interface Free_running_timer :I Maone
Systermn_frequency 200000000
System_timer :|T3, reload fram T2
Timer_interrupt_level :I 7
Timer_interrupt_level_group :l 0
« | 2
Status |
0K : ﬁ
Ok | Apply | Help |

The C166 Resource Configuration window consists of the following
elements:

¢ Active Configurations panel: This panel displays a list of currently
active configurations. To edit a configuration, click its entry in the
list. The parameters for the selected configuration then appear in the
System Configuration panel.

To link back to the library associated with an active configuration,
right-click its entry in the list. From the menu that appears, select
Go to library.
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C166
Resource
Configuration
Window
Parameters

To see documentation associated with an active configuration,
right-click its entry in the list. From the menu that appears, select
Help.

e System Configuration panel: This panel lets you edit the
parameters of the selected configuration. The parameters of each
configuration type are detailed in “C166 Resource Configuration
Window Parameters” on page 7-13.

Note Click Apply to make your changes take effect.

e Status panel: The Status panel displays error messages that may
arise if resource allocation conflicts are detected in the configuration.

¢ OK button: Dismisses the window.

The following sections describe the parameters for each type of
configuration in the C166 Resource Configuration window. The default
parameter settings are optimal for most purposes. If you want to change
the settings, read the relevant sections of the C166 User’s Manual. You
can find this document at the Infineon Web site at the following URL:

http://www.infineon.com/

For the ST10 User’s Manual, see the ST Microelectronics Web site at
following URL:

http://www.st.com/

7-13


http://www.infineon.com/
http://www.st.com/

C166 Resource Configuration

7-14

C166 System Configuration Parameters

=10l
i Syatetn Configuration |
""""" External_oscillator_frequency 0000000
o1 BBdriversitayhchronouzSynchronous Serial Interface Free_running_timer :I Mone
Systerm_frequency 20000000.0
Systermn_timer :|T3, reload from T2
Timer_interrupt_lewvel ﬂ T
Timer_interrupt_lewvel_group :l I}
« | 2
Statuz |
0K : ﬁ
Ok | Apply | Help |

External_oscillator_frequency

Depending on your hardware variant, the Real-Time Clock (RTC)
may be driven directly by the external oscillator input and it is,
therefore, important that the external oscillator frequency is set
correctly. Otherwise, if the RTC is used to provide any timing
services, the behavior will be incorrect. The default value for
external oscillator frequency is 5 MHz. You should check your
hardware manual to establish the correct value for your setup.
Note you can choose the RTC as a System_timer, see below.

Free_running_timer

This parameter allows one of the on-chip timers to be configured
for use with execution profiling. The selected timer is configured
to run indefinitely at a known frequency and is used by the
execution profiling engine to record the times at which tasks
start or finish executing. See Chapter 5, “Execution Profiling” for
more details.
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To find supported timer configurations, you should check the
General Purpose Timer section of the relevant User’s Manual for
your C166 microcontroller derivative.

System_frequency
You must set the system frequency of your C166 microcontroller
hardware here. Note that the value depends on your hardware
type and configuration. If you choose an incorrect value the model
will be correspondingly fast or slow.

System_timer
You must select which timer to use for generating interrupts to
drive the model update rate. You should select a timer, or timer
pair, that you do not intend to use for any other purpose within
your application. We recommend you choose a pair of timers, e.g.,
T6, with reload from CAPREL. This will give the best possible
sample time accuracy with no long term drift caused by higher
priority interrupts. If you choose a single timer, e.g., T2 or RTC,
the timer value will be reloaded within the timer interrupt service
routine. With this approach, any delay in servicing the timer
interrupt will be added to the time until the next timer interrupt
is generated.

To find supported timer configurations, you should check the
General Purpose Timer section of the relevant User’s Manual for
your C166 microcontroller derivative.

Timer_interrupt_level and Timer_interrupt_level_group
These two parameters together set the priority of sample time
interrupts. You should choose values such that the sample time
interrupts are suitably prioritized relative to other interrupts
used by your application.
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Asynchronous/Synchronous Serial Interface Configuration

Parameters

<} C166 Resource Configuration

=101.%]

|1

I Active Configurations

Asyhchronous/Synchronous Serial Configuration

— Bit_rate_achieved

— Bit_rate_ideal

— Loopback_mode_enahle

— hade_cantral

— Parity_selectian

— Receive_huffer_size

— Receive_interrupt_level

— Receive_interrupt_level_group
— S0CON

—— Btop_hits

— Transmit_huffer_size

— Transrmit_interrupt_lewvel

— Transmit_interrupt_level_group

& T

9615385

8600.0
:l Standard transmitireceive mode
:l 8-hit data, asynchronous

| nia
2

3
|14
|
0x8011
:IOnestupbit
3z
=14
>|o

Status

0 :

Ok | Apply | Help

=1
=1
|

Bit_rate_achieved

This read-only field shows the achieved serial interface bit rate. In
general, this value differs slightly from the requested bit rate, but
is the closest value that can be achieved by setting allowed values
in C166 register SOBG and bitfield SOBRS of register SOCON.

Bit_rate_ideal

Enter the desired bit rate for serial communications in this field.
Appropriate register settings are calculated automatically. You
can verify the actual bit rate in the Bit_rate_achieved field.
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Loopback_mode_enable
Select this entry to operate the serial interface in loopback mode.
This may be useful for test purposes where the serial interface is
required to receive data that it transmitted itself.

Mode_control
Select the desired combination of word length and parity/no
parity. See the C166 User’s Manual for more details.

Parity_selection
If parity is enabled, you must select odd or even.

Receive_buffer_size
You must select the size of the RAM buffer that will be used by
the serial receive driver. The maximum allowed value is 254.

Receive_interrupt_level and Receive_interrupt_level_group
Set the receive interrupt priority here. Note that the Target
Support Package drivers allow only interrupt levels 14 and 15 to
be used. The reason for this is that the drivers use the peripheral
event controller (PEC), which provides very fast interrupt
response but is restricted to levels 14 and 15.

SO0CON
This is a noneditable field that shows the value of the serial
interface register SOCON and how it varies as dialog box settings
are changed.

Stop_bits
You must select either 1 or 2 stop bits.

Transmit_buffer_size
See Receive buffer_ size.

Transmit_interrupt_level and Transmit_interrupt_level_group
See Receive parameters above.
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o BEdrivers

-

| Interface

CAN Configuration Parameters

<} C166 Resource Configuration

=1 CAN_A

— CARN_Int_Level_Group
— CAMN_Interrupt_Level
[ Masks

— Buffer_14_Mask

+— CAN_B

— C166_Transmit_Buffer_Mumhber

c1BBCanfig CAN_PROPS
14

|1

|0
c1BBCanfio CAN_MASKS
1FFFFFFF

— Global_kask_Edended 1FFFFFFF
— Global_kMask_Standard TFF
- Module_Enabled [ True

= Tirming c1BEConfig. CAN_TIMIMNG
— CAR_Bit_Rate 500000.0
— Mumber_Of_Quanta 20
— Resychronization_Jump_Width 4
— Sample_Faint n.81
- Transmit_Zueue_Length 16

c16EConfig. CAN_PROPS

Status

0K :

I

Ok | Apply | Help

The parameters listed below are the same for CAN modules A and B.

C166_Transmit_Buffer Number
This parameter is read only; all transmitted messages are sent
from buffer 14.

CAN_Int_Level_Group and CAN_Interrupt_Level
These two parameters together set the priority of sample time
interrupts. You should choose values such that the sample time
interrupts are suitably prioritized relative to other interrupts

7-18



C166 Resource Configuration

used by your application. Note that CAN module interrupts
must be set to a higher priority than timer interrupts. Use the
Validate Configuration button to make sure you do not select
an interrupt level that is already in use.

Masks

You can use these mask configuration parameters to choose to ignore
certain bits. In general, a CAN message is received only if its identifier
1s an exact match with the identifier specified in one of the receive
buffers. You can use mask parameters to indicate that some of the bits
in the received message identifier are “don’t care.”

Buffer_15_Mask
This mask applies to buffer 15 only. Each bit in the mask that is
set to zero causes the corresponding bit in the received message
identifier to be ignored when comparing it to the message
identifier that buffer 15 is configured to receive.

Global_Mask_Extended
This mask applies to any of buffers 1 to 14 that are configured
to receive messages with an extended identifier. Each bit in
the mask that is set to zero causes the corresponding bit in the
received message identifier to be ignored when comparing it to the
message identifier that this buffer is configured to receive.

Global_Mask_Standard
This mask applies to any of buffers 1 to 14 that are configured
to receive messages with an standard identifier. Each bit in
the mask that is set to zero causes the corresponding bit in the
received message identifier to be ignored when comparing it to the
message identifier that this buffer is configured to receive.

Module_Enabled
If the module is enabled, then initialization code for that CAN
module is generated. Use this setting to prevent generation of
driver code for a CAN module that is not required, or not available
on your hardware variant.
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Timing
CAN_Bit_Rate
Enter the desired bit rate. The default bit rate is 500000.

Number_Of _Quanta
The number of CAN module clock ticks per message bit.

Resynchronization_Jump_Width
The maximum number of clock ticks that the CAN device can
resynchronize over when it detects that it is losing message
synchronization.

Sample_Point
The point in the message where the CAN module samples the
value of the message bit.

Transmit_Queue_Length
Length (number of messages) of the transmit queue. The transmit
queue holds messages that are waiting to be transmitted. An
increase in performance can be achieved by reducing the queue
length. However, if the queue’s length is too small, it may become
full, causing messages to be lost.
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TwinCAN Configuration Parameters

-ioix)
I #Active Configurations [{' C166 TwinCAM Configuration
e 166ConTio TwinCAN_PROPS
cl66drivers/TwinCAM Interface CAM_int_level_group 1 .
CAM_interrupt_lewvel 10 -
Module_enabled # [V True
=1 Timing c166Config. TwinCAM_TIMING
CAN_hit_rate S00000.0 @
Mumber_of_gquanta 20 @
Resynchronization_jump_width 4 @
Sample_poink 0.581 @
CAN_B claaConfig. TwinZAN_PROPS
|ASt'atus |
bK :
oK | Apply | Help |

The TwinCAN Configuration Parameters are a subset of the “CAN
Configuration Parameters” on page 7-18, plus these additional
parameters:

TwinCAN_Rx_Pin
Select the desired pin. The default is P4.5(CAN_A) or
P9.0(CAN_B).

TwinCAN_Tx_Pin
Select the desired pin. The default is P4.6(CAN_A) or
P9.1(CAN_B).
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C-CAN Configuration Parameters

-ioix)
I Active Configur ations [{ C166 C-CAMN Configuration
——— = C168Confio.C_CAN PROPS
CAMN_ink_level_group 1 -
CAN_interrupt_level 10 -
Madule_enabled B [V True
B Timing c166Canfig.C_CAN_TIMING
CAN_bit_rate S00000.0 &
Mumber_of _quanta 20 &
Resynchranization_jurmp_width 4 @
Sample_point 0.81 @
CAN_2 c166Config. C_CAM_PROPS
CAM_modules_share_pins @ | [ False
CAM_transmit_lines_open_drain @ | [ False
‘St'atus |
ok
oK | Apply | Help |

The C-CAN Configuration Parameters are the same subset of the “CAN
Configuration Parameters” on page 7-18 as the TwinCAN Configuration
Parameters, plus the following two settings. The parameters are the
same for C-CAN modules 1 and 2.

CAN_modules_share_pins
When this option is not selected (the default), C-CAN modules 1
and 2 are connected to separate I/O pins. Use this option if C-CAN
modules 1 and 2 both share the same microcontroller I/0 pins P4.5
(receive) and P4.6 (transmit). In this mode both CAN modules are
connected to the same CAN bus via a shared transceiver. This
option takes effect only if both C-CAN modules are enabled. See
the microcontroller User Manual for more details.

CAN_transmit_lines_open_drain
When selected, the transmit lines for both CAN 1 and CAN 2 are
configured for open drain. Use this option if both C-CAN modules
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are connected (externally from the microcontroller) to the same
CAN transceiver. This option takes effect only if both C-CAN
modules are enabled and if the option for both modules to use

shared pins is not selected. See the microcontroller User Manual
for more details.
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Purpose

Library

Description

CAH_A
Blus Off Status

CAN Bus Status

Dialog
Box

Output Bus Off or Error Warning state of CAN module

Target Support Package/ Supported Processors/ Infineon C166/ CAN
Interface

The CAN Bus Status block provides an indicator of the state of the
selected CAN module. The block has a single output that may be set to
indicate either the Bus Off or Error Warning state of the module.

Block Parameters: CAN Bus Status |

— C166 CAN Bus Status [maszk] [link]

I1ze thiz block to determine if the CAM contraller iz in either Buz OFF state
or Ermor Warning state.

— Parameters
Modl: | |
Status bype: IBus aif j
S ample time:

|1

[~ Enable pass through [show simulation input)

k. I Cancel Help Spply

Module
Select CAN module A or B.

Status type
Choose Bus Off or Error Warning.
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Sample time
The sample time of this block.
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Purpose

Library

Description

CCp

CAN Calibration Frotocol

Implement CAN Calibration Protocol (CCP) standard

Target Support Package/ Supported Processors/ Infineon C166/ CAN
Interface

The CAN Calibration Protocol (C166) block provides an implementation
of a subset of the CAN Calibration Protocol (CCP) Version 2.1. CCP is a
protocol for communicating between the target processor and the host
machine over CAN. In particular, a calibration tool (see “Compatibility
with Calibration Packages” on page 7-31) running on the host can
communicate with the target, allowing remote signal monitoring and
parameter tuning.

This block processes a Command Receive Object (CRO) and outputs
the resulting Data Transmission Object (DTO) and Data Acquisition
(DAQ) messages.

For more information on CCP, refer to ASAM Standards: ASAM MCD:
MCD Ia on the Association for Standardization of Automation and
Measuring Systems (ASAM) Web site at http://www.asam.de.

Using the DAQ Output

Note The CCP Data Acquisition (DAQ) List mode of operation is only
supported with the Real-Time Workshop Embedded Coder product. If
this is not available then custom storage classes canlib.signal are
ignored during code generation: this means that the CCP DAQ Lists
mode of operation cannot be used.

You can use the CCP Polling mode of operation with or without the
Real-Time Workshop Embedded Coder product.

The DAQ output is the output for any CCP Data Acquisition (DAQ) lists
that have been set up. You can use the ASAP2 file generation feature of
the Real-Time (RT) target to


http://www.asam.de
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® Set up signals to be transmitted using CCP DAQ lists.

® Assign signals in your model to a CCP event channel automatically
(see “Parameter Tuning and Signal Logging” on page 2-17).

Once these signals are set up, event channels then periodically fire
events that trigger the transmission of DAQ data to the host. When this
occurs, CAN messages with the appropriate CCP/DAQ data appear on
the DAQ output, along with an associated function call trigger.

The calibration tool (see “Compatibility with Calibration Packages” on
page 7-31) must use CCP commands to assign an event channel and
data to the available DAQ lists, and interpret the synchronous response.

Using DAQ lists for signal monitoring has the following advantages
over the polling method:

® There is no need for the host to poll for the data. Network traffic is
halved.

® The data i1s transmitted at the correct update rate for the signal.
Therefore, there is no unnecessary network traffic generated.

® Data is guaranteed to be consistent. The transmission takes
place after the signals have been updated, so there is no risk of
interruptions while sampling the signal.

Note The Target Support Package product does not currently support
event channel prescalers.
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Dialog
Box

7-28

[E]Block Parameters: CAN Calibration Protocol

—CAM Calibration Protocal [C1EE] [mask] (link]

Implements CAM Calibration Protocol [CCF +2.1] on the target processor,

Thiz block, proceszes Command Receive Object [CRO) meszages and outputs the
rezulting Data Transmizzion Object [DTO] and Data Acquisition [DAD] meszages.

—Parameters

CCP station address (16-bit integer];

b2 ']

Cam module:l A
CAM meszage identifier [CRO);

| hew2decBFA)

CAM meszage type [CHD]:I Extended [29-bit identifier]
CAMN meszage identifier [DT0/DAQ]:

| hew2decBFE')

[v FIFO queue length [DAQ) equals number of 00Tz
FIFD queue length [DAG];

CAM message type [DTO/DAR]: I Extended [29-bit identifier]

Total number of Object Dezcriptor Tables (ODTz):

ja
CRO zample time:

[T}

ak I Cancel |

| Apply

CAN station address (16 bit integer)

The station address of the target. The station address is
interpreted as a uint16. It is used to distinguish between
different targets. By assigning unique station addresses to targets
sharing the same CAN bus, it is possible for a single host to

communicate with multiple targets.

CAN module
Choose CAN module A or B.
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CAN message identifier (CRO)
Specify the CAN message identifier for the Command Receive
Object (CRO) message you want to process.

CAN message type (CRO)
The incoming message type. Select either Standard(11-bit
identifier) or Extended(29-bit identifier).

CAN message identifier (DTO/DAQ)
The message identifier is the CAN message ID used for Data
Transmission Object (DTO) and Data Acquisition (DAQ) message
outputs.

CAN message type (DTO/DAQ)
The message type to be transmitted by the DTO and DAQ
outputs. Select either Standard(11-bit identifier) or
Extended(29-bit identifier).

FIFO queue length (DAQ) equals number of ODTs
Leave this check box selected to automatically set the FIFO queue
length equal to the number of Object Descriptor Tables (ODTSs)
(recommended). Clear the check box to set the length of the FIFO
queue manually.

FIFO queue length (DAQ)
Specify the FIFO queue length manually. This is enabled if you
clear the check box to set the queue length automatically.

Total number of Object Descriptor Tables (ODT's)
The default number of Object Descriptor Tables (ODTSs) is 8.
These ODTs are shared equally between all available DAQ lists.
You can choose a value between 0 and 254, depending on how
many signals you wish to log simultaneously. You must make
sure you allocate at least 1 ODT per DAQ list, or your build will
fail. The calibration tool will give an error message if there are too
few ODTs for the number of signals you specify for monitoring. Be
aware that too many ODTs can make the sample time overrun.
If you choose more than the maximum number of ODTs (254),
the build will fail.
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A single ODT uses 56 bytes of memory. Using all 254 ODTs would
require over 14 KB of memory, a large proportion of the available
memory on the target. To conserve memory on the target, the
default number is low, allowing DAQ list signal monitoring with
reduced memory overhead and processing power.

As an example, if you have five different rates in a model, and
you are using three rates for DAQ, then this will create three
DAQ lists and you must make sure you have at least three ODTs.
ODTs are shared equally among DAQ lists and, therefore, you will
end up with one ODT per DAQ list. With less than three ODTs,
you get zero ODTs per DAQ list and the behavior is undefined.

Taking this example further, say you have three DAQ lists with

one ODT each, and start trying to monitor signals in a calibration
tool. If you try to assign too many signals to a particular DAQ list
(that 1s, signals requiring more space than seven bytes (one ODT)
in this case), then the calibration tool will report this as an error.

CRO sample time

The sample time for CRO messages.

Supported CCP Commands

The following CCP commands are supported by the CAN Calibration
Protocol (C166) block:

CONNECT
DISCONNECT
DNLOAD

DNLOAD_6
EXCHANGE_ID
GET_CCP_VERSION
GET_DAQ_SIZE
GET_S_STATUS
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e SET_DAQ_PTR
e SET_MTA

e SET_S_STATUS

* SHORT_UP

e START_STOP

e START_STOP_ALL
o TEST

e UPLOAD

e WRITE_DAQ

Compatibility with Calibration Packages

The above commands support

® Synchronous signal monitoring via calibration packages that use
DAQ lists

® Asynchronous signal monitoring via calibration packages that poll
the target

® Asynchronous parameter tuning via CCP memory programming

This CCP implementation has been tested successfully with the
Vector-Informatik CANape calibration package running in both DAQ
list and polling mode, and with the Accurate Technologies, Inc., Vision,
calibration package running in DAQ list mode. (Note that Accurate
Technologies, Inc., Vision does not support the polling mechanism for
signal monitoring).
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Purpose Implement CAN Calibration Protocol (CCP) standard with C-CAN
Librclry Target Support Package/ Supported Processors/ Infineon C166/ C-CAN
Interface
Description
CCF
(- CAM)

CAMN Calibration Protocol

The CAN Calibration Protocol (C166, C-CAN) block is for the C-CAN
interface and performs the same functions as the CAN Calibration
Protocol (C166) block. For block parameter descriptions, see the CAN
Calibration Protocol (C166) reference page.
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Purpose
Library

Description

Implement CAN Calibration Protocol (CCP) standard for XC16x
variants of Infineon C166 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/ CAN
Interface

The CAN Calibration Protocol (C166, TwinCAN) block is for the
TwinCAN interface and performs the same functions as the CAN
Calibration Protocol (C166) block. For block parameter descriptions, see
the CAN Calibration Protocol (C166) reference page.
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Purpose
Library

Description

Pack individual signals into CAN message
CAN Communication

The CAN Pack block loads signal data into a message at specified
intervals during the simulation.

Note To use this block, you also need a license for Simulink software.

CAN Pack block has one input port by default. The number of input
ports is dynamic and depends on the number of signals you specify
for the block. For example, if your block has four signals, it has four
input ports.

Signali
Signalz hlessage: CAN Msg
. Standard |b: 250 CAN Msgp
Signal3
Signald

CAN Fack

This block has one output port, CAN Msg. The CAN Pack block takes
the specified input parameters and packs the signals into a message.

Other Supported Features

The CAN Pack block supports:

¢ The use of Simulink® Accelerator™ mode. Using this feature, you can
speed up the execution of Simulink models.

¢ The use of model referencing. Using this feature, your model can
include other Simulink models as modular components.

® Code generation using Real-Time Workshop to deploy models to
targets.



CAN Pack

Dialog
Box

Note Code generation is not supported if your signal information
consists of signed or unsigned integers greater than 32-bits long.

For more information on these features, see the Simulink

documentation.

Use the Function Block Parameters dialog box to select your CAN Pack

block parameters.

51
—CAN Pack
Pack data into a CAN Message.
—Parameters
Data is input as: Iraw data LI
CANdb file: I Browse... |
Message list: I(none} LI
—Message
Mame: ICAN Msg
Identifier type: IStandard {11-bit identifier) j
Identifier: I 250
Length (bytes): IB
™ Remote frame
QK I Cancel Help Apply

Parameters

Data is input as
Select your data signal:

¢ raw data: Input data as a uint8 vector array. If you select this
option, you only specify the message fields. All other signal
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parameter fields are unavailable. This option opens only one
input port on your block.

manually specified signals: Allows you to specify data signal
definitions. If you select this option, use the Signals table to
create your signals. The number of input ports on your block
depends on the number of signals you specify.

x
—CAN Pack
Pack data into a CAN Message,
—Parameters
Data is input as: |manual|y specified signals LI
CANdb file: I Browse... |
Message list: I(none} LI
—Message
Mame: IC.-'-\N Msg
Identifier type: IStandard {11-bit identifier) LI
Identifier: I 250
Length (bytes): |8
™ Remote frame
Signals: Add signal Delete signal
Name Ei‘frt t:i';f}m E:’;:r E;p‘:’ ’t‘lﬂ:p‘e" T;'L:’:"e" Factor |Offset |Min |Max
Signall 1] B|LE = |[signed LIStandard hd o 1 0| -Inf| Inf
Signal2 8 slte =llsigned  =|fstandard |+ 0 1 0| Inf| Inf
Signal3 16 8jle =|jsigned  =|lstandard =] 0 1 0| Anf| Inf
Signald| 24 8jle =|jsigned  =|lstandard  +| 0 1 0| Anf| Inf
oK I Cancel | Help | Apply |

¢ CANdb specified signals: Allows you to specify a CAN
database file that contains message and signal definitions. If
you select this option, select a CANdb file. The number of input
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ports on your block depends on the number of signals specified
in the CANdD file for the selected message.

[ Function Block Parameters: CAN Pack x|

—CAN Pack

Pack data into a CAN Message.,

—Parameters
Data is input as: |CANdb specified signals LI
CANdb file: ICANdeiIes.dbc Browse... |
Message list: IDDDrConh’oIMsg LI
—Message
Mame: I DoorControlMsg
Identifier type: IStandard {11-bitidentifier) LI
Identifier: |4DD

Length {bytes): |8

™ Remote frame

Signals: Add signal Delete signal
Start [Length |Byte |Data Multiplex Multiplex X
Name bit i) e = s value Factor |Offset |[Min |Max
DriverD 1 1LE _x Jjunsigned LI Standard x| 1] 1 1] 1] 1
Passen; 1] 1LE _x Jjunsigned jlstandard hd 1] 1 1] 1] 1

QK I Cancel | Help | Apply:

CANdbD file
This option is available if you specify that your data is input via
a CANdb file in the Data is input as list. Click Browse to find
the appropriate CANdD file on your system. The message list
specified in the CANdD file populates the Message section of the
dialog box. The CANdb file also populates the Signals table for
the selected message.
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Message list
This option 1s available if you specify that your data is input via a
CAN(db file in the Data is input as field and you select a CANdb
file in the CANdDb file field. Select the message to display signal
details in the Signals table.

Message

Name
Specify a name for your CAN message. The default is CAN
Msg. This option is available if you choose to input raw data or
manually specify signals. This option in unavailable if you choose
to use signals from a CANdD file.

Identifier type
Specify whether your CAN message identifier is a Standard or an
Extended type. The default is Standard. A standard identifier
is an 11-bit identifier and an extended identifier is a 29-bit
identifier. This option is available if you choose to input raw data
or manually specify signals. For CANdb specified signals, the
Identifier type inherits the type from the database.

Identifier
Specify your CAN message ID. This number must be a positive
integer from O through 2047 for a standard identifier and from
0 through 536870911 for an extended identifier. You can also
specify hexadecimal values using the hex2dec function. This
option is available if you choose to input raw data or manually
specify signals.

Length (bytes)
Specify the length of your CAN message from 0 to 8 bytes. If you
are using CANdb specified signals for your data input, the
CAN(db file defines the length of your message. If not, this field
defaults to 8. This option is available if you choose to input raw
data or manually specify signals.

Remote frame
Specify the CAN message as a remote frame.
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Signals Table

This table appears if you choose to specify signals manually or define
signals using a CANdb file.

If you are using a CANdb file, the data in the file populates this table
automatically and you cannot edit any fields. To edit signal information,
switch to manually specified signals.

If you have selected to specify signals manually, create your signals
manually in this table. Each signal you create has the following values:

Name
Specify a descriptive name for your signal. The Simulink block
in your model displays this name. The default is Signal [row
number].

Start bit
Specify the start bit of the data. The start bit is the least
significant bit counted from the start of the message data. The
start bit must be an integer from O through 63.

Length (bits)
Specify the number of bits the signal occupies in the message. The
length must be an integer from 1 through 64.

Byte order
Select either of the following options:

e LE: Where the byte order is in little-endian format (Intel®).
In this format you count bits from the start, which is the
least significant bit, to the most significant bit, which has the
highest bit index. For example, if you pack one byte of data in
little-endian format, with the start bit at 20, the data bit table
resembles this figure.
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7-40

Bit Number

Bit 7

Bit6

Bit5

Bit 4

Bit3

Bit 2

Bit1l

Bit 0

Byte 0

Data Byte Number

15

3l

14

a0

13

23

12

Data be

qgins at the least si

gnificant

11

10

Byte 3 bit and starts at 20

a9 as a7 a6 s 34 a3 3z

Data is writen up to the most significant

Byte 4 bit and ends at 27

47 a6 45 44 43 42 41 40
Byte §

55 54 53 52 51 50 43 43
Byte 6

63 62 &1 60 59 58 57 56
Byte 7

Little-Endian Byte Order Counted from the Least Significant Bit
to the Highest Address

BE: Where byte order is in big-endian format (Motorola®). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit. For example, if you
pack one byte of data in big-endian format, with the start bit at
20, the data bit table resembles this figure.
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Bit Number
Bit7 Bité Bit5 Bitd| Bit3| Bit2| Bitl| Bit0

Data Byte Number

13 17
Data iswriten up to the most
significant bit and ends at |11

31 a0 29 27 26 5 24
Data begins at the least significant

Byte 3 it and starts at 20

a9 L a7 a6 as 34 a3 az
Byte 4

47 a6 45 44 43 42 41 40
Byte §

55 54 53 52 51 50 43 43
Byte 6

63 62 61 &0 59 58 57 56
Byte 7

Big-Endian Byte Order Counted from the Least Significant Bit
to the Lowest Address

Data type
Specify how the signal interprets the data in the allocated bits.
Choose from:

® signed (default)
® unsigned

® single

® double
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Multiplex type
Specify how the block packs the signals into the CAN message
at each timestep:

e Standard: The signal is always packed at each timestep.

® Multiplexor: The Multiplexor signal, or the mode signal is
always packed. You can specify only one Multiplexor signal
per message.

e Multiplexed: The signal is packed if the value of the
Multiplexor signal (mode signal) at run time matches the
configured Multiplex value of this signal.

For example, a message has four signals with the following types

and values.
Signal Name Multiplex Type Multiplex Value
Signal-A Standard N/A
Signal-B Multiplexed 1
Signal-C Multiplexed 0
Signal-D Multiplexor N/A

In this example:

¢ The block packs Signal-A (Standard signal) and Signal-D
(Multiplexor signal) in every timestep.

e [f the value of Signal-D is 1 at a particular timestep, then the
block packs Signal-B along with Signal-A and Signal-D in that
timestep.

e [f the value of Signal-D is 0 at a particular timestep, then the
block packs Signal-C along with Signal-A and Signal-D in that
timestep.

e [f the value of Signal-D is not 1 or 0, the block does not pack
either of the Multiplexed signals in that timestep.
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Multiplex value

This option is available only if you have selected the Multiplex
type to be Multiplexed. The value you provide here must match
the Multiplexor signal value at run time for the block to pack
the Multiplexed signal. The Multiplex value must be a positive
integer or zero.

Factor

Specify the Factor value to apply to convert the physical value
(signal value) to the raw value packed in the message. See
“Conversion Formula” on page 7-43 to understand how physical
values are converted to raw values packed into a message.

Offset

Min

Max

Specify the Offset value to apply to convert the physical value
(signal value) to the raw value packed in the message. See
“Conversion Formula” on page 7-43 to understand how physical
values are converted to raw values packed into a message.

Specify the minimum physical value of the signal. The default
value 1s -inf (negative infinity). You can specify any number
for the minimum value. See “Conversion Formula” on page 7-43
to understand how physical values are converted to raw values
packed into a message.

Specify the maximum physical value of the signal. The default
value is inf. You can specify any number for the maximum
value. See “Conversion Formula” on page 7-43 to understand
how physical values are converted to raw values packed into a
message.

Conversion Formula

The conversion formula is

raw_value = (physical_value - Offset) / Factor
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where physical value is the value of the signal after it is saturated
using the specified Min and Max values. raw_value is the packed
signal value.

See Also CAN Unpack
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Purpose
Library

Description

can_a M
Receive hizg

CAMN Receive

Receive CAN messages from CAN module on Infineon C166
microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/ CAN
Interface

The CAN Receive block receives CAN messages from a CAN module.
The CAN Receive block can reserve one of the buffers on the CAN
module. Alternatively, you can instruct the CAN Receive block to select
a hardware buffer automatically from the available buffers. The CAN
Receive block has two outputs: a data output and a function-call trigger
output. The CAN Receive block polls its message buffer at a rate
determined by the block’s sample time. When the CAN Receive block
detects that a message has arrived, the function-call trigger is activated.
You should use a function-call subsystem, activated by the trigger, to
decode the message available at the CAN Receive block data output.
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Dialog x|

Box —C166 CAN Receive (mask) (ink)

Receives CAN messages from the selected CAN module.

—Parameters

CAN module: I.ﬁ. j

CAN message identifier:

Ihexldec('DDD 1)
CAN message identifier type: IStandard {11-bit identifier) j
Buffer selection: IAub:umaﬁc j

Buffer number [1..15]:
|1

Unpacking block compatibility: |Wz=iVgleklaxglsls]lad

Sample time:

|1

0K I Cancel Help

CAN module
Select CAN module A or B. The CAN modules can receive
messages independently.

CAN message identifier
The identifier of the message you want to receive. Note that if you
have set the CAN configuration parameters in your model to mask
out certain bits (e.g., the message identifier field), you may receive
messages with identifiers other than the identifier specified here.
See “CAN Configuration Parameters” on page 7-18.

CAN message identifier type
The type of message you want to receive. Select either
Standard(11-bit identifier) or Extended(29-bit
identifier).
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Buffer selection
Choose Automatic or Manual. When the automatic option is
selected, the CAN Receive block automatically selects a receive
buffer from the available buffers. Use this automatic buffer
selection, unless you want to use buffer 15 with its individually
programmable mask.

Buffer number [1..15]
This field is enabled if the Buffer selection is Manual. The buffer
number specifies the identifier of the receive buffer for this block.
Select Automatic buffer selection instead of manually specifying
the buffer, unless you want to use buffer 15 with its individually
programmable mask.

Unpacking block compatibility
Select Use unpacking block or Use message unpacking block
(obsolete). Choose the latter only if you are using the obsolete
Can Message Blocks library (canblocks.mdl).

Note If you have models that use host-side CAN blocks from the
obsolete Can Message Blocks library (canblocks.mdl), you will
see an obsolescence warning message. You should update your
models, as the host-side CAN blocks may be removed in a future
release

Sample time
Determines the rate at which to sample the buffer to see if a new

message has arrived.

Note The CAN Receive block sample time must be set to a value
that is smaller than the minimum time between CAN messages
that will be received into the corresponding buffer. If more than
one message 1s received into a buffer during a single sample
interval, the older message will be overwritten.
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Purpose Reset CAN module

Library Target Support Package/ Supported Processors/ Infineon C166/ CAN
Interface

Description The CAN Reset block reinitializes the CAN module. We recommend

that you place this block in a triggered subsystem, with a sample time
of -1 (inherited).

CAaM_A
Resat

CAN Reset

DIGIOg Block Parameters: CAN Resek =]

Box —C166 CAMN Buz Status [maszk] [link]

Ilze this block to determine if the CaM controller iz in either Bus Off state
or Ermar Warhing state.

— Parameters
ocuie: [T ~
5 ample firme;

1
] I Cancel Help Apply

Module
Select CAN module A or B.

Sample time
The sample time of this block.
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Purpose
Library

Description

CAaM_A
Tranzmit

CAN Transmit

Transmit CAN messages via CAN module on Infineon C166
microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/ CAN
Interface

The CAN Transmit block transmits a CAN message onto the CAN bus.
Three modes of transmission are available with the CAN Transmit
block.

The default mode is to use a priority-based message queue shared by
all transmit blocks operating in this mode; the priority-based message
queue operates with CAN buffer 14; when a message is successfully
transmitted from this buffer, an interrupt is generated and the highest
priority message from the queue is loaded into the hardware buffer
ready to be transmitted. This mode has the advantage of allowing
several messages with different identifiers to be transmitted without
each message requiring a dedicated hardware buffer. Note that
although messages are taken from the queue in order of priority, it is
possible for a low priority message to be present in the hardware buffer
and higher priority messages cannot then be transferred from the queue
until transmission of the low priority message is complete.

The second transmit mode is to use a dedicated CAN buffer; in this
case, messages to be transmitted are loaded directly into a CAN
buffer that is used exclusively by the block. No queue is used, which
means that in case the previous message has not been transmitted,
it will be overwritten by the new one. This transmit mode does not
use interrupts. An advantage of using the dedicated buffer mode is
that there is reduced delay in transmitting high-priority messages,
and reduced processor overhead that is otherwise required for queue
management and servicing interrupts.

The third transmit mode is to use a First In First Out (FIFO) queue
with dedicated buffer. In this mode, messages are placed in a queue
and then transmitted on a first in, first out basis. This mode is useful
if several messages, possibly with the same CAN identifier, must be
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transmitted in sequence; this may be a requirement if CAN is being
used for data acquisition.

The CAN Transmit block should be connected to CAN Message
Packing/Unpacking blocks. Do not ground the block or leave it
unconnected.

Dialog 2

Box —C1B6 CAN Transmit [mask) (link]
Tranzmitz a CAN meszage wia the selected CAN module.
—Parameters
acule: [ - |
Transmit mode: I GHueued transmizsion with shared buffer ;I
Sample time:
[
ok Cancel Help Spply
Module

Select CAN module A or B.. The CAN modules can receive
messages independently.

Transmit mode
Select one of the three modes described above: queued
transmission with shared buffer, direct transmission with
dedicated buffer, or FIFO queue with dedicated buffer.

Buffer selection

Only for selecting dedicated buffers — available only if you select
direct transmission or FIFO queue transmit modes. Choose either

automatic or manual selection of the hardware buffer number.
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Buffer number
This option is available only if the buffer selection is available and
set to manual. You must select a buffer number between 1 and
14. Note if more than one message is ready to be transmitted,
then the one in the lower buffer number will be sent first. Select
buffer numbers such that the higher the message priority, the
lower the buffer number.

Sample time
Choose -1 to inherit the sample time from the driving blocks. The
CAN Transmit block does not inherit constant sample times and
runs at the base rate of the model if driven by invariant signals.
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Purpose Unpack individual signals from CAN messages
. . .
lerclry CAN Communication
L L
Description
Signal1
DriverDoorLod
u CCAN N A Signalz File: demoWNT_CANdEFiles.dbe
cAN MegtiEssage: CAN Msg AN M Message: CAN Msg -
CAN Msg Standard |D- 250 Dats CAN Msg Standard 10: 250 . CAN Msg Message: DoorControlMsg
Signal2 Standard |0 250
PassengerDoorlodk
Signal4
CAN Unpadk

(With raw data cutput)

CAN Unpade

{With manusally specified data cutput)

CAN Unpadk
(With CANdE specified data cutput)

The CAN Unpack block unpacks a CAN message into signal data using
the specified output parameters at every timestep. Data is output as

individual signals.

Note To use this block, you also need a license for Simulink software.

The CAN Unpack block has one output port by default. The number
of output ports is dynamic and depends on the number of signals you
specify for the block to output. For example, if your block has four

signals, it has four output ports.

Meszage: CAN hisg

AN
*9 standard ID: 250

Signali
Signalz
Signalz

Signald

CAMN Unpack

Other Supported Features

The CAN Unpack block supports:
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® The use of Simulink Accelerator mode. Using this feature, you can
speed up the execution of Simulink models.

® The use of model referencing. Using this feature, your model can
include other Simulink models as modular components.

® Code generation using Real-Time Workshop to deploy models to
targets.

Note Code generation is not supported if your signal information
consists of signed or unsigned integers greater than 32-bits long.

For more information on these features, see the Simulink
documentation.
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Dialog Use the Function Block Parameters dialog box to select your CAN
Box message unpacking parameters.
x
—CAM Unpack

Unpack data from a CAM Message.

—Parameters
Data to be output as: ©
CANdb file: I Browse... |
Message list: |(none} LI
—Message
Mame: |CAN Msg
Identifier type: |Standard (11-bit identifier) ;I
Identifier: I 250

Length (bytes): I 8

—Output ports

[~ output identifier [~ Cutput tmestamp [~ Cutput error

[ output remate [~ output length ™ output status
CK I Cancel Help Apply
Parameters

Data to be output as
Select your data signal:

* raw data: Output data as a uint8 vector array. If you select
this option, you only specify the message fields. All other signal
parameter fields are unavailable. This option opens only one
output port on your block.

e manually specified signals: Allows you to specify data
signals. If you select this option, use the Signals table to
create your signals message manually.
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x
—CAM Unpack-
Unpack data from a CAN Message.
—Parameters
Data to be output as:
CANdb file: I Browse... |
Message list: I(none} LI
Messag
MName: ICAN Msg
Identifier type: IStandard {11-bit identifier) j
Identifier: I 250
Length (bytes): |8
Signals: Add signal Delete signal |
Name Ei‘frt E’E}m E:’;:r E::: ’;ﬂ:de“ T;'L:’:"e" Factor |Offset |Min |Max
Signall 1] 8|LE = ||signed LlStandard hd 1] 1 0| -Inf| Inf
Signal2 8 sfie =lfsigned  =[fstandard =] 0 1 0| Inf| Inf
Signal3 16 8JlE =lfsianed  =lfstandard x| 0 1 0| Inf| Inf
Signal4| 24 8|l =llsigned  =|lstandard =] 0 1 0| Anf| Inf
—Output ports
[T Output identifier [~ Output timestamp [~ output error
[~ output remote ™ Output length ™ Output status
Ok I Cancel | Help | Apply

The number of output ports on your block depends on the

number of signals you specify. For example, if you specify four

signals, your block has four output ports.

CANdb specified signals: Allows you to specify a CAN
database file that contains data signals. If you select this
option, select a CANdD file.
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E! Function Block Parameters: CAN Unpack (With CANdb specified data output)

—CAM Unpack-

Unpack data from a CAN Message.

—Parameters

Data to be output as:

CANdb file: I CANdbFiles.dbc Browse... |

Message list: IDDDrConh’oIMsg LI
Messag
Mame: I DoorControlMsg
Identifier type: IStandard (11-bit identifier) j
Identifier: |4DD

Length (bytes): I 8

Signals: Add signal Delete signal |
Start [Length |Byte |Data Multiplex Multiplex .
Name bit (bits) order value Factor |Offset |Min |Max
DriverD 1 LLE = Jjunsigned LI Standard x| o] 1 1] 1] 1
Passeny 1] LLE = Jjunsigned LIIStandard hd o] 1 1] 1] 1
—Output ports

™ output identifier [~ Output timestamp [~ output error
™ Output remate ™ Output length ™ Output status

oK I Cancel | Help | Apply

The number of output ports on your block depends on the
number of signals specified in the CANdb file. For example, if
the selected message in the CANdb file has four signals, your
block has four output ports.

CANdb file
This option 1s available if you specify that your data is input via a
CAN(db file in the Data to be output as list. Click Browse to
find the appropriate CANdb file on your system. The messages
and signal definitions specified in the CANdDb file populate the
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Message section of the dialog box. The signals specified in the
CAN(db file populate Signals table.

Message list
This option is available if you specify that your data is to be
output as a CANdD file in the Data to be output as list and you
select a CANdb file in the CANdDb file field. You can select the
message that you want to view. The Signals table then displays
the details of the selected message.

Message

Name
Specify a name for your CAN message. The default is CAN Msg.
This option is available if you choose to output raw data or
manually specify signals.

Identifier type
Specify whether your CAN message identifier is a Standard or an
Extended type. The default is Standard. A standard identifier
is an 11-bit identifier and an extended identifier is a 29-bit
identifier. This option is available if you choose to output raw
data or manually specify signals. For CANdb-specified signals,
the Identifier type inherits the type from the database.

Identifier
Specify your CAN message ID. This number must be a integer
from O through 2047 for a standard identifier and from 0 through
536870911 for an extended identifier. If you specify 1, the block
unpacks all messages that match the length specified for the
message. You can also specify hexadecimal values using the
hex2dec function. This option is available if you choose to output
raw data or manually specify signals.

Length (bytes)
Specify the length of your CAN message from 0 to 8 bytes. If you
are using CANdb specified signals for your output data, the
CANCdb file defines the length of your message. If not, this field
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defaults to 8. This option is available if you choose to output raw
data or manually specify signals.

Signals Table

This table appears if you choose to specify signals manually or define
signals using a CANdDb file.

If you are using a CANdDb file, the data in the file populates this table
automatically and you cannot edit any fields. To edit signal information,
switch to manually specified signals.

If you have selected to specify signals manually, create your signals
manually in this table. Each signal you create has the following values:

Name
Specify a descriptive name for your signal. The Simulink block
in your model displays this name. The default is Signal [row
number].

Start bit
Specify the start bit of the data. The start bit is the least
significant bit counted from the start of the message. The start
bit must be an integer from 0 through 63.

Length (bits)
Specify the number of bits the signal occupies in the message. The
length must be an integer from 1 through 64.

Byte order
Select either of the following options:

¢ LE: Where the byte order is in little-endian format (Intel). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit, which has the
highest bit index. For example, if you pack one byte of data in
little-endian format, with the start bit at 20, the data bit table
resembles this figure.
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Bit Number

Bit 7

Bit6

Bit5

Bit 4

Bit3

Bit 2

Bit1l

Bit 0

Byte 0

Data Byte Number

15

3l

14

a0

13

23

12

11

10

Data begins at the least significant

Byte 3 bit and starts at 20

a9 as a7 a6 s 34 a3 3z

Data is writen up to the most significant

Byte 4 bit and ends at 27

47 a6 45 44 43 42 41 40
Byte §

55 54 53 52 51 50 43 43
Byte 6

63 62 &1 &0 59 58 57 56
Byte 7

Little-Endian Byte Order Counted from the Least Significant Bit
to the Highest Address

BE: Where the byte order is in big-endian format (Motorola). In
this format you count bits from the start, which is the least
significant bit, to the most significant bit. For example, if you
pack one byte of data in big-endian format, with the start bit at
20, the data bit table resembles this figure.
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Bit Number

Bit7

Data Byte Number

18

17

Data iswriten up to the most
significant bit and ends at |11
31 a0 29 27 26 5 24
Data begins at the least significant
Byte 3 it and starts at 20
a9 L a7 a6 as 34 a3 az
Byte 4
47 a6 45 44 43 42 41 40
Byte §
55 54 53 52 51 50 43 43
Byte 6
63 62 61 &0 59 58 57 56
Byte 7

Big-Endian Byte Order Counted from the Least Significant Bit
to the Lowest Address

Data type
Specify how the signal interprets the data in the allocated bits.

Choose from:

signed (default)

unsigned
single
double
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Multiplex type
Specify how the block unpacks the signals from the CAN message
at each timestep:

e Standard: The signal is always unpacked at each timestep.

® Multiplexor: The Multiplexor signal, or the mode signal is
always unpacked. You can specify only one Multiplexor signal
per message.

e Multiplexed: The signal is unpacked if the value of the
Multiplexor signal (mode signal) at run time matches the
configured Multiplex value of this signal.

For example, a message has four signals with the following values.

Signal Name Multiplex Type Multiplex Value
Signal-A Standard N/A

Signal-B Multiplexed 1

Signal-C Multiplexed 0

Signal-D Multiplexor N/A

In this example:

® The block unpacks Signal-A (Standard signal) and Signal-D
(Multiplexor signal) in every timestep.

e [f the value of Signal-D is 1 at a particular timestep, then the
block unpacks Signal-B along with Signal-A and Signal-D in
that timestep.

e [f the value of Signal-D is 0 at a particular timestep, then the
block unpacks Signal-C along with Signal-A and Signal-D in
that timestep.

e [f the value of Signal-D is not 1 or 0, the block does not unpack
either of the Multiplexed signals in that timestep.
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Multiplex value
This option is available only if you have selected the Multiplex
type to be Multiplexed. The value you provide here must match
the Multiplexor signal value at run time for the block to unpack
the Multiplexed signal. The Multiplex value must be a positive
integer or zero.

Factor
Specify the Factor value applied to convert the unpacked raw
value to the physical value (signal value). See “Conversion
Formula” on page 7-63 to understand how unpacked raw values
are converted to physical values.

Offset
Specify the Offset value applied to convert the physical value
(signal value) to the unpacked raw value. See “Conversion
Formula” on page 7-63 to understand how unpacked raw values
are converted to physical values.

Min
Specify the minimum raw value of the signal. The default value
is -inf (negative infinity). You can specify any number for the
minimum value. See “Conversion Formula” on page 7-63 to
understand how unpacked raw values are converted to physical
values.

Max
Specify the maximum raw value of the signal. The default value
is inf. You can specify any number for the maximum value. See
“Conversion Formula” on page 7-63 to understand how unpacked
raw values are converted to physical values.

Output Ports

Selecting an Output ports option adds an output port to your block.

Output identifier
Select this option to output a CAN message identifier. The data
type of this port is uint32.
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See Also

Output remote
Select this option to output the message remote frame status.
This option adds a new output port to the block. The data type of
this port is uint8.

Output timestamp
Select this option to output the message time stamp. This option
adds a new output port to the block. The data type of this port
is double.

Output length
Select this option to output the length of the message in bytes.
This option adds a new output port to the block. The data type of
this port is uint8.

Output error
Select this option to output the message error status. This option
adds a new output port to the block. The data type of this port is
uint8.

Output status
Select this option to output the message received status. The
status 1s 1 if the block receives new message and 0 if it does not.
This option adds a new output port to the block. The data type of
this port is uint8.

If you do not select any Output ports option, the number of output
ports on your block depends on the number of signals you specify.

Conversion Formula

The conversion formula is

physical_value = raw_value * Factor + Offset

where raw_value is the unpacked signal value. physical value is the
scaled signal value which is saturated using the specified Min and
Max values.

CAN Pack
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Purpose

Library

Description

ccaM 1 0
Receive  pyzq

C-CAM Receive

Receive CAN messages from C-CAN module on ST10 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/ C-CAN
Interface

The C-CAN Receive block receives CAN messages from a C-CAN
module. The C-CAN Receive block automatically reserves one of the
buffers on the C-CAN module. The C-CAN Receive block has two
outputs: a data output and a function-call trigger output. The C-CAN
Receive block polls its message buffer at a rate determined by the
block’s sample time. When the CAN Receive block detects that a
message has arrived, the function-call trigger is activated. You should
use a function-call subsystem, activated by the trigger, to decode the
message available at the CAN Receive block data output.



C-CAN Receive

Dialog
Box

E! Source Block Parameters: C-CAN Receive |

—C166 C-CAN Receive (mask) {link)

Receives CAN messages from the selected C-CAN module.

—Parameters

C-CAM module: I 1 j

CAN message identifier:

I hex2dec(00017)

CAN message identifier type: IStandard (11-bit identifier) j

Unpacking block compatibility:

Sample time:

|1

0K I Cancel Help

C-CAN module
Select C-CAN module 1 or 2. The C-CAN modules can receive
messages independently.

CAN message identifier
The identifier of the message you want to receive.

CAN message identifier type
The type of message you want to receive. Select either
Standard(11-bit identifier) or Extended(29-bit
identifier).

Unpacking block compatibility
Select Use unpacking block or Use message unpacking block
(obsolete). Choose the latter only if you are using the obsolete
Can Message Blocks library (canblocks.mdl).
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Note If you have models that use host-side CAN blocks from the
obsolete Can Message Blocks library (canblocks.mdl), you will
see an obsolescence warning message. You should update your
models, as the host-side CAN blocks may be removed in a future
release

Sample time
Determines the rate at which to sample the buffer to see if a new
message has arrived.

Note The C-CAN Receive block sample time must be set to a
value that 1s smaller than the minimum time between CAN
messages that will be received into the corresponding buffer. If
more than one message is received into a buffer during a single
sample interval, the older message will be overwritten.
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Purpose

Library

Description

C-CAHM 1
Transmit

C-CAM Transmit

Transmit CAN messages via C-CAN module on ST10 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/ C-CAN
Interface

The C-CAN Transmit block transmits a CAN message onto the CAN
bus. Two modes of transmission are available with the C-CAN Transmit
block.

The default transmit mode is to use a dedicated CAN buffer; in this
case, messages to be transmitted are loaded directly into a CAN
buffer that is used exclusively by the block. No queue is used, which
means that in case the previous message has not been transmitted,
it will be overwritten by the new one. This transmit mode does not
use interrupts. An advantage of using the dedicated buffer mode is
that there is reduced delay in transmitting high-priority messages,
and reduced processor overhead that is otherwise required for queue
management and servicing interrupts.

The other transmit mode is to use a First In First Out (FIFO) queue
with dedicated buffer. In this mode, messages are placed in a queue
and then transmitted on a first in, first out basis. This mode is useful
if several messages, possibly with the same CAN identifier, must be
transmitted in sequence; this may be a requirement if CAN is being
used for data acquisition.

The C-CAN Transmit block should be connected to CAN Message
Packing/Unpacking blocks. Do not ground the block or leave it
unconnected.
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Dialog
Box

7-68

E Sink Block Parameters: C-CAN Transmit |
— C166 C-CAMN Transmit [maszk] [link)

Tranzmits a CAM message via the zelected C-CAN module.

r— Parameter:

C-CAN Module: |1 =]

with dedicated buffer

Buffer number [0, 31]:
Jo

Sample time;

|

0K I LCancel Help Apply

C-CAN Module
Select C-CAN module 1 or 2.. The C-CAN modules can receive
messages independently.

Transmit mode
Select one of the two modes described above: direct transmission
with dedicated buffer, or FIFO queue with dedicated buffer.

Length (number of messages) of FIFO queue
This option is available only if you select the transmit mode FIFO
queue with dedicated buffer.

Buffer number
This parameter is for information only. It may be useful for
reviewing code to know which hardware buffer is used for which
block.

Sample time
Choose -1 to inherit the sample time from the driving blocks. The
CAN Transmit block does not inherit constant sample times and
runs at the base rate of the model if driven by invariant signals.



Digital In

Purpose

Library

Description

Digital In
on P20

Digital In

Dialog
Box

Digital input driver that reads value of specified port or pin number

Target Support Package/ Supported Processors/ Infineon C166/ Digital
Input/Output

The Digital In block reads the logical state of the specified pin and
outputs a value of zero or one accordingly.

E! Source Block Parameters: Digital In Ed

—LC1EE Drigital Input [maszk] [link]

Reads the logical state of the specified pin and outputs a walue of 2era or ohe
accordingly.

The pin must be an integer value in the range O to 7 far ports that are 8 bits wide ar O
to 15 for ports that are 16 bits wide.

—Parameterz

Pot
Fir:

o

Sample time:

01

ok Cancel Help

Port
Select a port. Options are POL, POH, P1L, P1H, P2—P8.
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Pin
The pin must be an integer value in the range 0 to 7 for ports that
are 8 bits wide, or 0 to 15 for ports that are 16 bits wide.

Sample time
The time interval between samples. The default is 0.1. See
“Specifying Sample Time” in the Simulink documentation for
more information.
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Purpose

Library

Description

Digital Cut
on P20

Digital Cut

Dialog
Box

Digital output driver that sets logical state of specified pin

Target Support Package/ Supported Processors/ Infineon C166/ Digital
Input/Output

The Digital Out block sets the logical state of the specified pin according
to the input signal. When the input signal is greater than zero, a logical
one is written to the selected pin; otherwise a logical zero is written.

=1 sink Block Parameters: Digital Duk

—LC166 Digital Output [mazk] [link]

Setz the logical state of the zpecified pin. Yhen the input zignal iz greater than zero a
logizal one iz written to the selected pin; otherwize a logical zera iz written.

The pin muzt be an integer value in the range 0 ta 7 for ports that are 8 bitz wide ar 0
to 15 for parts that are 16 bitz wide.

—Parameters
Por. [ |
Fir:
|0
Sample time:
[
ok LCancel Help | Apply |
Port

Select a port. Options are POL, POH, P1L, P1H, P2—P8 (not P5).
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Pin
The pin must be an integer value in the range 0 to 7 for ports that
are 8 bits wide, or 0 to 15 for ports that are 16 bits wide.

Sample time
The time interval between samples. The default is -1, inherited.
See “Specifying Sample Time” in the Simulink documentation for
more information.
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Purpose

Library

Description

Fast External
Interrupt on F2.8

Fast External Interrupt

Generate asynchronous function-call trigger when interrupt occurs

Target Support Package/ Supported Processors/ Infineon C166/
Interrupts

The Fast External Interrupt block executes a function-call triggered
subsystem in the context of the service routine for a fast external
interrupt. To generate the interrupt, you must select one of the upper
eight pins of Port 2 (P2.8 to P2.15)

The function-call subsystem will be executed as an asynchronous
task. Use this block to assign the task a Simulink priority and a CPU
interrupt level. The settings that you assign must be consistent with
priorities and interrupt levels of other tasks defined in the model.

Limitations on XC16x Hardware

On XC16x hardware, this block is unable to generate code to enable
fast external interrupts. Fast external interrupts must be enabled by
setting bits in the register EXICON. On XC16x devices this register is
write protected after execution of the special EINIT instruction by the
processor’s register security mechanism. It is not possible for the driver
block to generate code that is executed before the EINIT instruction.

If you want to use this block on XC16x hardware, you must set the
required bits in register EXICON in the Project Options within the
Tasking EDE. For example, to enable fast external interrupts on rising
or falling edges for both of pins P2.8 and P2.9 (as required by the demo
model c166_async), follow these steps:

1 Build the model c166_async.
2 Open the project c166_async_c166 within the Tasking EDE.
3 Select Project > Project Options.

4 In the Project Options dialog box, select in the tree
Application > Startup > EXICON.

a Set the value to 0x000F.
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7-74

Dialog
Box

b Select the check box to Include in startup code.
5 From within the Tasking EDE, re-build the project c166_async_c166.

6 Download to the XC16x by launching Crossview from the CrossView
button in the Tasking EDE.

Alternatively, you can create a new template project with the required
setting for EXICON. You can easily create a new template project.
Enter taskingutils in the Command Window to open the Embedded
IDE Link Utilities for Use with TASKING dialog box, and select Create
New Template Projects.

Port 2 pin number
Select a port. Options are 8 to 15.

Trigger mode
Select from Rising or falling edge (the default), Rising edge,
Falling edge, or Disabled.

Priority
Set a Simulink priority. The default is 30.

Interrupt level
Select an interrupt level from 1 to 15. The default is 5.

Interrupt level group
Select an interrupt level group from 0 to 3. The default is 1.

Show simulation input
Select this check box (and click Apply) to get an input port for
simulation.



Serial Receive

Purpose

Library

Description

Configure C166 microcontroller for serial receive

Target Support Package/ Supported Processors/ Infineon C166/
Asynchronous/Synchronous Serial Interface

The Serial Receive block receives bytes over the Infineon C166
microcontroller Synchronous/Asynchronous Serial Interface ASCO. It
requests either a fixed number of bytes to be received, or by enabling
the first input, a variable number of bytes can be requested each time
this block is called.

When the block is called, the requested number of bytes are retrieved
from a FIFO buffer that is internal to the device driver. If this buffer
contains fewer bytes than the number requested, these bytes are pulled
from the buffer and made available at the block output. The number of
bytes actually retrieved from the buffer is made available at the second
output. This block retrieves only those bytes that have already been
received and placed in the internal buffer; it never waits for additional
data to be received.

Whenever bytes are received at the serial interface, a Peripheral Event
Controller (PEC) interrupt is generated to move the byte into the
internal buffer. If there is no more space available in the internal
buffer, any additional data is lost. The PEC interrupts are extremely
fast and have minimal effect on the rest of the application.

To configure the serial interface bit rate, buffer size, PEC interrupt
priority, and other parameters, see “Asynchronous/Synchronous Serial
Interface Configuration Parameters” on page 7-16.
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Note If your model contains a serial transmit or receive block, it is not
possible to perform on-chip debugging over the same serial interface.
Attempting to use the debugger in this case causes an error. If you
need to debug an application that includes the serial transmit and
receive blocks, you must run the debugger using a hardware simulator;
alternatively, it may be possible to run your debugger on-chip without
using the serial interface, for example, if debugging over CAN is
available. See “Debugging and Using The Code Profile Report” on page
2-11.

Block Inputs and Outputs

The input can be enabled so a variable number of bytes can be requested
each time.

The first output pulls bytes from the buffer — either the number
requested or the number available, whichever is the lower. Note that
the number requested is the value of input signal if supplied, or the
width of output signal otherwise.

The second output is the number of bytes actually retrieved from the
buffer.
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Dlalog Block Parameters: Serial Receive 3 |
Box — S-Function [mask) (link]
— Parameterz

[+ Show number of bytes read:
[¥ Show length input:

b axiriurn length of data:

|1

Sample tirme:

f1
ak. I Cancel Help Spply

Show number of bytes read
Enables second output to show actual number of bytes retrieved
from the buffer.

Show length input
Enables inport so you can vary the number of bytes requested
per call.

Maximum length of data
Set this as required up to the maximum buffer size. You can
set receive and transmit buffer size (up to a maximum of 256
bytes) within the C166 Resource Configuration object. See
“Asynchronous/Synchronous Serial Interface Configuration
Parameters” on page 7-16.

Sample time
The time interval between samples. The default is 1. To inherit
the sample time, set this parameter to -1. See “Specifying Sample
Time” in the Simulink documentation for more information.
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Purpose

Library

Description

Data ,org
Transmit

Serial Transmit

Configure Infineon C166 microcontroller for serial transmit

Target Support Package/ Supported Processors/ Infineon C166/
Asynchronous/Synchronous Serial Interface

The Serial Transmit block transmits bytes over the Infineon C166
microcontroller Synchronous/Asynchronous Serial Interface ASC0. You
can use it either to transmit a fixed number of bytes, or by enabling
the second input, transmit a variable number of bytes each time this
block is called.

When the block is called, the specified number of bytes are placed in a
FIFO buffer that is internal to the device driver. If this buffer is already
full, or if the number of spaces available is too few, then not all of the
bytes requested will actually be queued for transmit; in this case, the
number of bytes actually transmitted can be determined from block
output.

Once bytes are queued for transmit, they will be sent as fast as possible
by the serial interface hardware with no further intervention required
by the main application. Note that after each byte is sent, a Peripheral
Event Controller (PEC) interrupt is generated to fetch the next byte
from the internal buffer. The PEC interrupts are extremely fast and
have minimal effect on the rest of the application.

To configure the serial interface bit rate, buffer size, PEC interrupt
priority, and other parameters, see “Asynchronous/Synchronous Serial
Interface Configuration Parameters” on page 7-16.



Serial Transmit

Note If your model contains a serial transmit or receive block, it is not
possible to perform on-chip debugging over the same serial interface.
Attempting to use the debugger in this case causes an error. If you
need to debug an application that includes the serial transmit and
receive blocks, you must run the debugger using a hardware simulator;
alternatively, it may be possible to run your debugger on-chip without
using the serial interface, for example if debugging over CAN is
available. See “Debugging and Using The Code Profile Report” on page
2-11.

Block Inputs and Outputs

The first input contains the data to be transmitted; this input signal
may be either a vector or scalar with data type uint8.

The optional second input must be a scalar and may be used to control
the number of bytes transmitted. The number of bytes to transmit
should not be greater than the width of the first input signal.

The block output port actual number of bytes output gives the
number of bytes queued for transmit. If there was sufficient space in
the buffer, this number will be equal to the requested number of bytes
to transmit.
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Dia IOg Block Parameters: Serial Transmiktl =]
Box — S-Function [mazk) (link)
— Parameterz
Sample kime;

[+ Show length input:
[+ Show number of bytes zent

k. I Cancel Help Smply

Sample time
The time interval between samples. To inherit the sample time,
leave this parameter at the default -1. See “Specifying Sample
Time” in the Simulink documentation for more information.

Show length input
Enable/disable the number of bytes to send. If not selected,
the number of bytes sent is just the width of the first inport; if
selected, the second input is enabled, which controls the number

of bytes to send.

Show number of bytes sent
Enable/disable the number of bytes actually sent. If selected, this

value is available from the first output.
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Purpose
Library

Description

Configure model for external mode or executable building
Target Support Package/ Supported Processors/ Infineon C166/ Utilities

Place the Switch External Mode Configuration block in your model and
double-click it to run a convenience function to configure your model
for building an executable, or executing your model in external mode.
When you double-click the block, a dialog box appears. Choose either
Building an executable or External mode, and click OK.

When you choose building an executable, messages at the command line
inform you the following steps are taken to configure your model:

1 Inline parameters are selected (under Optimization in the
Configuration Parameters dialog box). This is required for ASAP2
generation

2 Normal simulation mode is selected (in the Simulation menu, and
drop-down list in the toolbar).

3 ASAP2 is selected as the Interface (under Real-Time Workshop,
Interface, in the Data Exchange pane, in the Configuration
Parameters dialog box).

When you choose external mode, messages at the command line inform
you the following steps are taken to configure your model:

1 Inline parameters are selected (under Optimization in the
Configuration Parameters dialog box). This is required for external
mode.

2 External simulation mode is selected (in the Simulation menu, and
drop-down list in the toolbar).

3 External mode is selected as the Interface (under Real-Time
Workshop, Interface, in the Data Exchange pane, in the
Configuration Parameters dialog box).
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See “Using External Mode” on page 2-17 for instructions for converting
a model to use external mode for signal logging and parameter tuning.
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Purpose

Library

Description

‘Switch Target
Caonfiguration

Switch Targst
Hardwars Cenfiguration

Configure model and Target Preferences to one of a set of predefined
hardware configurations

Target Support Package/ Supported Processors/ Infineon C166/ Utilities

Place the Switch Target Configuration block in your model and
double-click it to run a convenience function that configures your model
and Target Preferences to one of a set of predefined configurations. The
Embedded IDE Link Option Set Selection dialog box appears, and you
must choose a configuration for your processor type from the list. The
suffixes ’_hw’ and ’_sim’ mean hardware or instruction set simulator.
See “Option Sets” in the Embedded IDE Link documentation for more
information.
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) Embedded IDE Link Option Set Selection = |EI| ﬂ

Option sets are preconfigured settings to specify the target configuration
for the TASKIMG tools.

Plea=e choose an option set:

cl6Tcr_hw
c167er_gsim
cl67cs_hw
c167cs_sim
st10f252_hw
=t10f252_sim
st10f265_hw
st10f265_sim
xcl84ocm_hw_u_can
xc164cm_sim_u_can
®C167c_hw
xc167ci_hw_usb
®c167ci_sim

| oK | Cancel |

The predefined configurations include settings for

e Phytec phyCORE-167 ST10F269
¢ Phytec phyCORE-167 C167CS

¢ Phytec kitCON-167 C167CR

¢ Infineon XC167CI Starter Kit

The option set xc167ci_hw_usb is for USB wiggler connection to the
XC167CI.
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Note You must change jumper 501 when switching between USB
wiggler and on-board parallel port wiggler for this target.
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Purpose
Library

Description

TwinCAH_A
Bus Off Status

TwinCAN Bus Status

Output Bus Off or Error Warning state of a CAN node on XC16x
variants of Infineon C166 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/
TwinCAN Interface

The TwinCAN Bus Status block is for the TwinCAN interface and
performs the same functions as the CAN Bus Status block. For block
parameter descriptions, see the CAN Bus Status reference page.



TwinCAN Receive

Purpose
Library

Description

Receive CAN messages via TwinCAN module on XC16x variants of
Infineon C166 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/
TwinCAN Interface

The TwinCAN Receive block receives CAN messages from a TwinCAN
module. The TwinCAN Receive automatically reserves one of the
buffers on the TwinCAN module. The TwinCAN Receive block has

two outputs: a data output and a function call trigger output. The
TwinCAN Receive block polls its message buffer at a rate determined
by the block’s sample time. When the TwinCAN Receive block detects
that a message has arrived, the function call trigger is activated. You
should use a function call subsystem, activated by the trigger, to decode
the message available at the TwinCAN Receive block data output.

This block has the same parameters as the CAN Receive block, except
there is no option to Automatically select buffer or Buffer number.
For block parameter descriptions, see the CAN Receive reference page.
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Purpose

Library

Description

Reset CAN node on XC16x variants of Infineon C166 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/
TwinCAN Interface

The TwinCAN Reset block is for the TwinCAN interface and performs
the same functions as the CAN Reset block. For block parameter
descriptions, see the CAN Reset reference page.



TwinCAN Transmit

Purpose
Library

Description

Transmit CAN messages from TwinCAN module on XC16x variants
of Infineon C166 microcontrollers

Target Support Package/ Supported Processors/ Infineon C166/
TwinCAN Interface

The TwinCAN Transmit block transmits a CAN message onto the CAN
bus. Two modes of transmission are available with the CAN Transmit
block, as described below.

The first transmit mode is to use a dedicated CAN buffer; in this case,
messages to be transmitted are loaded directly into a CAN buffer
that is used exclusively by the block. No queue is used, which means
that in case the previous message has not been transmitted, it will
be overwritten by the new one. This transmit mode does not use
interrupts. An advantage of using the dedicated buffer mode is that
there is minimal delay in transmitting high-priority messages.

The second transmit mode is to use a First In First Out (FIFO) queue
with dedicated buffer. In this mode, messages are placed in a queue
and then transmitted on a first in, first out basis. This mode is useful
if several messages, possibly with the same CAN identifier, must be
transmitted in sequence; this may be a requirement if CAN is being
used for data acquisition.

The TwinCAN Transmit block should be connected to CAN Message
Packing/Unpacking blocks. Do not ground the block or leave it
unconnected.
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Dialog
Box
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[Z]Block Parameters: TwinCAN Transmik |

—C1EE TwinCaM Transmit [maszk] (link]

Transmite a CAMN meszage via the selected TwinCaMN module.

—Parameters
TwinCaN Node: |GG - |
Tranzmit made: I Drirect tranzmizsion with dedicated buffer |
Buffer zelection; |ﬁutnmatic LI
Buffer rnumber [0..31];
[
Sample time:
[

ok LCancel Help Spply

TwinCAN Node
Select node A or node B.

Transmit mode
Select one of the modes described above: direct transmission with
dedicated buffer, or FIFO queue with dedicated buffer.

Buffer selection
Choose either automatic or manual selection of the hardware
buffer number.

Buffer number [0..31]
This option is available only if the buffer selection is available and
set to manual. You must select a buffer number between 0 and 31.
Note if more than one message is ready to be transmitted, then
the one in the lower buffer number will be sent first. Select buffer
numbers such that the higher the message priority, the lower



TwinCAN Transmit

the buffer number. Note that the hardware buffers are shared
between node A and node B of the TwinCAN module.

Sample time
Choose -1 to inherit the sample time from the driving blocks.
The TwinCAN Transmit block does not inherit constant sample
times and runs at the base rate of the model if driven by invariant

signals.
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Real-Time Workshop Pane: €166 Options

Real-Time Workshop

| Templatez I Data Placement I Data Tvpe Replacement | tdemamy Sections C166 Options [1] | 4 | 3

™ Include input/output driver function hooks

I awirmurn number of concurrent base-rate overruns: |5

b aximum number of concurrent sub-rate overruns: ID

™ Execution profiling

Mumber of data paints: {500

I™ Generate code only Build |

Eevert Help | Apply |

In this section...

“C166 Options Tab Overview” on page 8-3

“Include input/output driver function hooks” on page 8-4
“Maximum number of concurrent base-rate overruns:” on page 8-5
“Maximum number of concurrent sub-rate overruns:” on page 8-7
“Execution profiling” on page 8-9

“Number of data points:” on page 8-10




Real-Time Workshop® Pane: C166 Options

C166 Options Tab Overview

Parameters for integrating your own device driver code and controlling
execution profiling with the Target Support Package product.

Configuration

This pane appears only if you specify the C166.t1lc or C166_grt.tlc system
target file.

See Also

® Overview of C166 Configuration Parameters

® Getting Started
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Include input/output driver function hooks

Specify whether to integrate your own device driver code.

Settings
Default: Off

¥ On
Include input/output driver function hooks. When you generate code for
this model, it includes some extra calls to user-supplied input/output
device driver functions, to read and write model inputs and outputs.
See Calling the Device Driver Functions from ¢166_main.c for function
names and instructions.

™ off

Do not include input/output driver function hooks.

Command-Line Information

Parameter: InputOutputDriverHooks
Type: logical

Value: 0 | 1

Default: 0

See Also
Integrating Your Own Device Drivers



Real-Time Workshop® Pane: C166 Options

Maximum number of concurrent base-rate overruns:
Configure allowable base-rate overruns.

Settings
Default: 5

Minimum: 0

Maximum: No maximum value — it depends on available memory.

Tips

Use this option to configure the behavior of the scheduler when timer based
tasks do not complete within their allowed sample time.

It is useful to allow task overruns in the case where a task may occasionally
take longer than usual to complete (e.g. if extra processing is required
when a special event occurs); if the task overrun is only occasional then it
is possible for the scheduler to ’catch up’ after the extra processing has
been completed.

If the maximum number of concurrent overruns for any task is exceeded,
this is deemed to be a failure and the real-time application is stopped.
This in turn will result in a watchdog timer timeout and the processor
will be reset.

The occurrence of base-rate overruns does not affect the numerical behavior
of the algorithm (although reading/writing external devices will of course
be delayed).

Command-Line Information

Parameter: BaseRateMaxOverrunsValue
Type: int

Value: 0 | 1 | 2...

Default: 5
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See Also

e Task Scheduler Overrun Options

¢ Execution Profiling



Real-Time Workshop® Pane: C166 Options

Maximum number of concurrent sub-rate overruns:

Configure allowable sub-rate overruns.

Settings
Default: 0

Minimum: 0

Maximum: No maximum value — it depends on available memory.

Tips

Note Allowing sub-rate overruns may cause non-determinism and loss of
integrity for data transferred between different rates in the model. Set this
value to zero if you require sub-rate overruns to be handled as a failure
(recommended).

e [f this option is set to a value greater than zero, then the behavior of any
Rate-Transition blocks may be affected. Specifically, if the model contains a
Rate Transition block where the option "Ensure deterministic data transfer
(maximum delay)" is selected, then this setting may not be honored.

e [If sub-rate overruns are allowed then the transfer of data between different
rates (via rate-transition blocks) in the model may be affected; this
causes the numerical behavior in real-time to differ from the behavior in
simulation. To see an illustration of this effect try running the demo model
c166_multitasking. To disallow sub-rate overruns and ensure that this
effect does not occur, you should set Maximum number of concurrent
sub-rate overruns to zero.

Command-Line Information

Parameter: SubRateMaxOverrunsValue
Type: int

Value: 0 | 1 | 2...

Default: 0
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See Also

e Task Scheduler Overrun Options

¢ Execution Profiling



Real-Time Workshop® Pane: C166 Options

Execution profiling
Specify whether to configure code for execution profiling.

Settings
Default: Off

¥ On
Include function calls in the generated code for the model at the
beginning and end of each task or asynchronous Interrupt Service
Routine (ISR) to be profiled. When you perform an execution profiling
run, these function calls read a timer and log this reading, along with a
task identifier, for uploading and analyzing.

I ofr

Do not add function calls for execution profiling.

Tip

When code for the model is generated, these function calls update data on
the worst-case turnaround time for each timer-based task as well as the
worst-case number of concurrent task overruns, whenever a previous worst
case value is exceeded. Additionally, when a trigger is provided, data can be
logged over a period of time to record all task start and task finish times. The
trigger signal can be supplied by the execution profiling blocks.

Dependency

This parameter enables Number of data points.

See Also

¢ Real-Time Workshop Options for Execution Profiling

¢ Execution Profiling
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Number of data points:

Specify number of data points to log for execution profiling runs.

Settings
Default: 500

Minimum: This depends on the number of tasks. Three is a sensible
minimum to get useful information back.

Maximum: No maximum value - it depends on available memory.

Tip

When a snapshot of task and ISR activity is logged, this data is stored in
memory that is statically allocated at build time. Each data point requires 4
bytes on C166 microcontrollers. The larger the number of data points to be
stored, the more RAM that must be reserved for this purpose. At the end of a
logging run, the data must be uploaded to the host computer for analysis; this
is typically achieved by using one of the C166 execution profiling blocks.

Dependency

This parameter is enabled by Execution Profiling.

Command-Line Information

Parameter: ExecutionProfilingNumSamples
Type: int

Value: 3 | 4 | 5...

Default: 500

See Also

e Number of Data Points

¢ Execution Profiling



Examples

Use this list to find examples in the documentation.



A Examples

Simple Example Applications

“Example Model 1: ¢166_serial_transmit” on page 2-4
“Example 2: ¢166_serial_i0” on page 2-9

“Debugging and Using The Code Profile Report” on page 2-11
“RAM / ROM Code Profile Report” on page 2-13

“Parameter Tuning and Signal Logging” on page 2-17

Real-Time Target
“Using External Mode” on page 2-17

Integrating Manually Coded Device Drivers

“Tutorial: Using the Example Driver Functions” on page 3-11

Bit-Addressable Memory

“Using the Bitfield Example Model” on page 4-3

Execution Profiling

“Multitasking Demo Model” on page 5-10
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